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1 Getting Started

Vehicle Dynamics Blockset Product Description

1-2

Model and simulate vehicle dynamics in a virtual 3D environment

Vehicle Dynamics Blockset™ provides fully assembled reference application models that simulate
driving maneuvers in a 3D environment. You can use the prebuilt scenes to visualize roads, traffic
signs, trees, buildings, and other objects around the vehicle. You can customize the reference models
by using your own data or by replacing a subsystem with your own model. The blockset includes a

library of components for modeling propulsion, steering, suspension, vehicle bodies, brakes, and
tires.

Vehicle Dynamics Blockset provides a standard model architecture that can be used throughout the
development process. It supports ride and handling analyses, chassis controls development, software
integration testing, and hardware-in-the-loop testing. By integrating vehicle dynamics models with a
3D environment, you can test ADAS and automated driving perception, planning, and control
software. These models let you test your vehicle with standard driving maneuvers such as a double
lane change or with your own custom scenarios.

Key Features

* Preassembled vehicle dynamics models for passenger cars and trucks

* Preassembled maneuvers for common ride and handling tests, including a double-lane change
+ 3D environment for visualizing simulations and communicating scene information to Simulink®
» Libraries of propulsion, steering, suspension, vehicle body, brake, and tire components

* Combined longitudinal and lateral slip dynamic tire models

* Predictive driver model for generating steering commands that track a predefined path

* Prebuilt 3D scenes, including straight roads, curved roads, and parking lots
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Required and Recommended Products

Required Products

Vehicle Dynamics Blockset product requires current versions of these products:

« MATLAB
e Simulink

Recommended Products

You can extend the capabilities of the Vehicle Dynamics Blockset using the following recommended

products.
Goal Recommended Products
Model events Stateflow®

Test closed-loop perception, planning, |Automated Driving Toolbox™
and control algorithms

Test vehicle-level integration Powertrain Blockset™

Optimize vehicle energy consumption,

ride and handling
Generate optimized suspension Model-Based Calibration Toolbox™
parameters
Simscape™ Multibody™
See Also
More About
. “3D Visualization Engine Requirements” on page 1-5
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3D Visualization Engine Requirements

3D Visualization Engine Requirements

The 3D visualization engine requires:

* A Windows® 64-bit platform. If you do not enable the 3D visualization engine, Vehicle Dynamics
Blockset runs on Windows, Mac, and Linux® 64-bit platforms.

+ Visual Studio® 2017 or higher.

* Microsoft® DirectX®. If it is not already installed on your machine, Vehicle Dynamics Blockset
prompts you to install the software the first time you enable 3D visualization.

To use the Vehicle Dynamics Blockset 3D visualization engine, consider these minimum hardware
requirements:

* Graphics card (GPU): Virtual Reality (VR) ready with 8-GB on-board RAM

* Processor (CPU): 2.60 GHz

* Memory (RAM): 12 GB

Limitations

The 3D visualization engine and blocks do not support:

* Code generation.
* Model reference.
* Multiple instances of the Simulation 3D Scene Configuration block.

* Multiple instances of the same actor tag. To refer to the same scene actor when you use the 3D
block pairs (e.g. Simulation 3D Actor Transform Get and Simulation 3D Actor Transform Set),
specify the same Tag for actor in 3D scene, Actortag parameter.

» Parallel simulations.
* Rapid accelerator mode.

See Also
Simulation 3D Scene Configuration

More About
. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6
. “Scene Interrogation in 3D Environment” on page 3-11

External Websites
. Unreal Engine
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Vehicle Dynamics Blockset Communication with 3D
Visualization Software

The vehicle dynamics models run programmable maneuvers in a photorealistic 3D visualization
environment. Vehicle Dynamics Blockset integrates the 3D simulation environment with Simulink so
that you can query the world around the vehicle for virtually testing perception, control, and planning
algorithms. The Vehicle Dynamics Blockset visualization environment uses the Unreal Engine® by
Epic Games.

When you use Vehicle Dynamics Blockset to run a maneuver, Simulink can co-simulate with the
visualization engine.

1-6

-
Determine positions of ] Transfation, rotation, scale + Position objects in 3D
objects » environment
Configure 3D environment J Scene information . Query 3D environment
Simulink Visualization

Engine

In the Simulink environment, Vehicle Dynamics Blockset:

* Determines the next position of objects by using 3D visualization environment feedback and
vehicle dynamics models.

* Configures the 3D visualization environment, specifically:

* Ray tracing
* Scene capture cameras

+ Initial object positions
In the visualization engine environment, Vehicle Dynamics Blockset positions the objects and uses ray
tracing to query the environment.

See Also

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-50
More About

. “3D Visualization Engine Requirements” on page 1-5

. “Scene Interrogation in 3D Environment” on page 3-11

External Websites

. Unreal Engine
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Engine Calibration Maps

Engine Calibration Maps

Calibration maps are a key part of the Mapped CI Engine and Mapped SI Engine blocks available in
the Vehicle Dynamics Blockset. Engine models use the maps to represent engine behavior and to
store optimal control parameters. Using calibration maps in control design leads to flexible, efficient
control algorithms and estimators that are suitable for electronic control unit (ECU) implementation.

To develop the calibration maps for engine plant models in the reference applications, MathWorks®
developed and used processes to measure performance data from 1.5-L spark-ignition (SI) and
compression-ignition (CI) engine models provided by Gamma Technologies LLC.

To represent the behavior of engine plants specific to your application, you can develop your own
engine calibration maps. The data required for calibration typically comes from engine dynamometer
tests or engine hardware design models.

Engine Plant Calibration Maps

The engine plant model calibration maps in the Mapped CI Engine and Mapped SI Engine blocks
affect the engine response to control inputs (for example, spark timing, throttle position, and cam
phasing).

To develop the calibration maps in the engine plant models, MathWorks used GT-POWER models from
the GT-SUITE modeling library in a Simulink-based virtual dynamometer. MathWorks used the Model-
Based Calibration Toolbox to create design-of-experiment (DoE) test plans. The Simulink-based virtual
dynamometer executed the DoE test plan on GT-POWER 1.5-L SI and CI reference engines.
MathWorks used the Model-Based Calibration Toolbox to develop the engine plant model calibration
maps from the GT-POWER.

Calibration Maps in the Mapped Cl Engine Block

The Mapped CI Engine block implements these calibration maps.

1-7
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fuel mass and
engine speed

Map Used For In Description
Engine brake |Engine brake |Mapped CI |The engine brake torque lookup table is a function of
torque torque as a Engine commanded fuel mass and engine speed, Ty qke = f(F,
function of N), where:
commanded
fuel mass and *  Tprake is engine torque, in N-m.
engine speed + Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.
£
Engine Speed (RPM) 0 o 0
Commanded Fuel (mg/inj)
Engine air Engine air mass [Mapped CI |The air mass flow lookup table is a function of
mass flow flow as a Engine commanded fuel mass and engine speed, Mjyk =
function of f(Fpax, N), where:
commanded

*  Minek is engine air mass flow, in kg/s.

Fra is commanded fuel mass, in mg per injection.

N is engine speed, in rpm.
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Engine Calibration Maps

Map Used For In Description
Engine fuel |Engine fuel flow [Mapped CI |The engine fuel flow lookup table is a function of
flow as a function of |Engine commanded fuel mass and engine speed, MassFlow=
commanded f(F, N), where:
fuel mass and _ . .
engine speed * MassFlow is engine fuel mass flow, in kg/s.
* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.
0.01
¥ o.008
E‘DDDE
% 0.004
=
© 0.002
o
6000
2000 20
Engine Speed (RPM) 0 0 1o
Commanded Fuel (mg/inj)
Engine Engine exhaust |[Mapped CI |The engine exhaust temperature table is a function of
exhaust temperature as |Engine commanded fuel mass and engine speed, T,,= f(F, N),
temperature |a function of where:

commanded
fuel mass and
engine speed

o T..nis exhaust temperature, in K.
* Fis commanded fuel mass, in mg per injection.
* N s engine speed, in rpm.

1400

< 1200
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6000

2000 20
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Engine Speed (RPM) 0 o
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Map

Used For

Description

Brake-specific

BSFC efficiency

Mapped CI

The brake-specific fuel consumption (BSFC) efficiency

fuel as a function of |Engine is a function of commanded fuel mass and engine
consumption |commanded speed, BSFC= f(F, N), where:
(BSFC) fuel mass and . '
efficiency engine speed * BSFCis BSFC, in g/kWh.

* Fis commanded fuel mass, in mg per injection.

* N is engine speed, in rpm.

Engine Speed (RPM) 0 g 10 v

Commanded Fuel (mg/inj)

Engine-out EO hydrocarbon |[Mapped CI |The engine-out hydrocarbon emissions are a function
(EO) emissions as a |Engine of commanded fuel mass and engine speed, EO HC=
hydrocarbon |function of f(F, N), where:
emissions commanded

fuel mass and
engine speed

* EO HC is engine-out hydrocarbon emissions, in
kg/s.

* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.

%1078
5

EOQHC (kg/s)
MW

2000 20

10
Engine Speed (RPM) 0 o

Commanded Fuel (mgfinj)




Engine Calibration Maps

Map Used For In Description
Engine-out EO carbon Mapped CI |The engine-out carbon monoxide emissions are a
(EO) carbon |monoxide Engine function of commanded fuel mass and engine speed,
monoxide emissions as a EO CO= f(F, N), where:
emissions function of ) . ] o ]
commanded * EO CO is engine-out carbon monoxide emissions, in
fuel mass and kg/s.
engine speed * Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.
2000 20
Engine Speed (RPM) 0 9 0
Commanded Fuel (mgfinj)
Engine-out EO nitric oxide |Mapped CI |The engine-out nitric oxide and nitrogen dioxide
(EO) nitric and nitrogen Engine emissions are a function of commanded fuel mass and
oxide and dioxide engine speed, EO NOx= f(F, N), where:
nitrogen emissions as a ) ) o ) )
dioxide function of * EO NOx is engine-out nitric oxide and nitrogen

commanded
fuel mass and
engine speed

dioxide emissions, in kg/s.
* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.

%1074
25

2

1.5

50

20
10
Engine Speed (RPM) 0 o

Commanded Fuel (mg/inj)
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commanded
fuel mass and
engine speed

Map Used For In Description

Engine-out EO carbon Mapped CI |The engine-out carbon dioxide emissions are a

(EO) carbon |dioxide Engine function of commanded fuel mass and engine speed,
dioxide emissions as a EO CO2= f(F, N), where:

emissions function of

* EO COZ2 is engine-out carbon dioxide emissions, in

kg/s.
* Fis commanded fuel mass, in mg per injection.
* N is engine speed, in rpm.

EO CO2 (kgis)

6000
50

2000 20

10
Engine Speed (RPM) 0 o
Commanded Fuel (mg/inj)

Calibration Maps in the Mapped SI Engine Block

The Mapped SI Engine block implements these calibration maps.

engine speed

Map Used For In Description

Engine torque |[Engine brake = |Mapped SI |The engine torque lookup table is a function of
torque as a Engine commanded engine torque and engine speed, T =
function of f(Tyma, N), where:
commanded
torque and * Tis engine torque, in N-m.

* T, is commanded engine torque, in N-m.
* N is engine speed, in rpm.

N o= n
=] o =]
=] (=1 =]

Actual Torgue (Nm)
3

2000
50
Engine Speed (RPM) 0 o

Commanded Torque (Nm)
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Engine Calibration Maps

Map Used For In Description
Engine air Engine air mass [Mapped SI |The engine air mass flow lookup table is a function of
mass flow flow as a Engine commanded engine torque and engine speed, Mjpsk =
function of f(T.mg, N), where:
commanded
torque and *  Mintk iS engine air mass flow, in kg/s.
engine speed * T, is commanded engine torque, in N-m.
* N is engine speed, in rpm.
0.1
% 0.08
g 0.06
LL;'J 0.04
S
E 0.02
1]
6000
200
2000
50
Engine Speed (RPM) 0 o
Commanded Torgue (Nm)
Engine fuel |Engine fuel flow [Mapped SI |The engine fuel mass flow lookup table is a function of
flow as a function of |Engine commanded engine torque and engine speed,
commanded MassFlow = f(T,,g, N), where:
torque mass i ) )
and engine * MassFlow is engine fuel mass flow, in kg/s.
speed * T, is commanded engine torque, in N-m.

* N is engine speed, in rpm.

X
@ 2
la

@

Fuel Mass Flow (kg/s)
L -
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¥

200

2000
50
Engine Speed (RPM) 0 o

Commanded Torgue (Nm)
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Map Used For In Description
Engine Engine exhaust |Mapped SI |The engine exhaust temperature lookup table is a
exhaust temperature as |Engine function of commanded engine torque and engine
temperature |a function of speed, To = f(T;g, N), where:
commanded ) .
torque and * T, is exhaust temperature, in K.
engine speed * T.ngis commanded engine torque, in N-m.
* N s engine speed, in rpm.
1200
% 1100
% 1000
é 900
'.G:L: 800
.‘.':E 700
. 600
6000
200
2000
50
Engine Speed (RPM) 0 o
Commanded Torque (Nm)
Brake-specific | Brake-specific |Mapped SI |The brake-specific fuel consumption (BSFC) efficiency
fuel fuel Engine is a function of commanded engine torque and engine

consumption
(BSFC)
efficiency

consumption
(BSEC) as a
function of
commanded
torque and
engine speed

speed, BSFC = f(T,,q4, N), where:

* BSFC is BSFC, in g/kWh.
* T,ngis commanded engine torque, in N-m.
* N s engine speed, in rpm.

200

50
Engine Speed (RPM) 0 o

Commanded Torque (Nm)




Engine Calibration Maps

Map Used For In Description
Engine-out  |EO hydrocarbon |Mapped SI |The engine-out hydrocarbon emissions are a function
(EO) emissions as a |Engine of commanded engine torque and engine speed, EO
hydrocarbon |function of HC = f(T g, N), where:
emissions commanded ] _ o .
torque and * EO HC is engine-out hydrocarbon emissions, in
engine speed kg/s.
* T, is commanded engine torque, in N-m.
* N is engine speed, in rpm.
%107
12
,

g 0.8

% 0.6

I

E 04

0.2
0
6000
200
2000
50
Engine Speed (RPM) 0 o
Commanded Torque (Nm)

Engine-out EO carbon Mapped SI |The engine-out carbon monoxide emissions are a
(EO) carbon |monoxide Engine function of commanded engine torque and engine
monoxide emissions as a speed, EO CO = f(T,g, N), where:
emissions function of

commanded
torque and
engine speed

* EO CO is engine-out carbon monoxide emissions, in
kg/s.

* T, is commanded engine torque, in N-m.
* N s engine speed, in rpm.

%103

50

Engine Speed (RPM) 0 o
Commanded Torgue (Nm)
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Map Used For In Description
Engine-out EO nitric oxide |Mapped SI |The engine-out nitric oxide and nitrogen dioxide
(EO) nitric and nitrogen Engine emissions are a function of commanded engine torque
oxide and dioxide and engine speed, EO NOx = f(T,,4, N), where:
nitrogen emissions as a ) . o .
dioxide function of * EO NOx is engine-out nitric oxide and nitrogen
emissions commanded dioxide emissions, in kg/s.
torque and * T.ngis commanded engine torque, in N-m.
engine speed * N is engine speed, in rpm.
x107*
1.5
2
&
=
Q 05
w
0
6000
50
Engine Speed (RPM) 0 o
Commanded Torque (Nm)
Engine-out EO carbon Mapped SI |The engine-out carbon dioxide emissions are a
(EO) carbon |dioxide Engine function of commanded engine torque and engine
dioxide emissions as a speed, EO CO2 = f(T g, N), where:
emissions function of , _ o o _
commanded * [EO CO2 is engine-out carbon dioxide emissions, in
torque and kg/s.
engine speed * T.ngis commanded engine torque, in N-m.
* N is engine speed, in rpm.
1‘_‘?"%—‘ o
=S
oY
2000
Engine Speed (RPM) 0 g
Commanded Torque (Nm)
See Also

Mapped CI Engine | Mapped SI Engine
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External Websites

. Virtual Engine Calibration: Making Engine Calibration Part of the Engine Hardware Design
Process
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Yaw Stability on Varying Road Surfaces

This example shows how to run the vehicle dynamics double-lane change maneuver on different road
surfaces, analyze the vehicle yaw stability, and determine the maneuver success.

ISO 3888-2! defines the double-lane change maneuver to test the obstacle avoidance performance of
a vehicle. In the test, the driver:

* Accelerates until vehicle hits a target velocity

* Releases the accelerator pedal

» Turns steering wheel to follow path into the left lane

* Turns steering wheel to follow path back into the right lane

Typically, cones mark the lane boundaries. If the vehicle and driver can negotiate the maneuver
without hitting a cone, the vehicle passes the test.

For more information about the reference application, see “Double-Lane Change Maneuver” on page
3-4.

Run a Double-Lane Change Maneuver

1 Create and open a working copy of the double-lane change reference application.

vdynblksDblLaneChangeStart
2 Open the Lane Change Reference Generator block. By default, the maneuver is set with these
parameters:
* Longitudinal entrance velocity setpoint — 35 mph
* Vehicle width — 2 m

* Lateral reference position breakpoints and Lateral reference data — Values that specify
the lateral reference trajectory as a function of the longitudinal distance

3 In the Visualization subsystem, open the 3D Engine block. By default, 3D Engine parameter is
set to Disabled. For the 3D visualization engine platform requirements and hardware
recommendations, see “3D Visualization Engine Requirements” on page 1-5.

4 Run the maneuver. As the simulation runs, view vehicle information.

* In the Vehicle Position window, view the vehicle longitudinal distance as a function of lateral
distance.
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matlab:vdynblksDblLaneChangeStart

Yaw Stability on Varying Road Surfaces
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Y Distance [m]

* In the Visualization subsystem, open the Lane Change scope block to display the lateral
displacement as a function of time.

* Red line — Cones marking lane boundary
* Blue line — Reference trajectory
* Green line — Actual trajectory

The green line does come close to the red line that marks the cones.
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Y
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* In the Visualization subsystem, if you enable the 3D Engine block visualization environment,
you can view the vehicle response in the AutoVrt1Env window.
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Sweep Surface Friction

Run the reference application on three road surfaces with different friction scaling coefficients. Use
the results to analyze the yaw stability and help determine the success of the maneuver.

1 In the double-lane change reference application model DLCReferenceApplication, open the
Environment subsystem. The Friction block parameter Constant value specifies the friction
scaling coefficient. By default, the friction scaling coefficient is 1.0. The reference application
uses the coefficient to adjust the friction at every time step.

2 In the Visualization subsystem, enable signal logging. You can use the Simulink editor or,
alternatively, MATLAB® commands. Save the model.

Model Element Simulink Editor

VehFdbk inport [ I ﬁ

=xdot=

WehFdbk
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Model Element Simulink Editor

Lane inport | [ S F

IS0 15037-1:2006 block Block Parameters: 150 15037-1:2006
ISO 15037-1:2006 (mask)

Enables display of ISO 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters
IS0 Measurements
® Enabled

isabled

3D Engine block Block Parameters: 3D Engine

3D Engine (mask)

This subsystem contains the intel
display of the vehicle in the 3D vi
the simulation progress, disable i

3D Engine Settings
3D Engine
(O Enabled
@ [giﬁabled

Alternatively, use these commands to enable the signal logging and save the model.

% Open the model
mdl = 'DLCReferenceApplication’;
open_system(mdl);

% Enable signal logging for VehFdbk
ph=get param('DLCReferenceApplication/Visualization/VehFdbk', 'PortHandles');
set param(ph.Outport, 'DataLogging','on');

% Enable signal logging for Lane
ph=get param('DLCReferenceApplication/Visualization/Lane', 'PortHandles"');
set param(ph.Outport, 'DataLogging','on');

% Enable signal logging for ISO block
set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable');
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% Disable 3D environment
set param([mdl '/Visualization/3D Engine'], 'engine3D', 'Disabled');

save system(mdl)

Set up a vector with the friction scaling coefficients, Lambdamu, that you want to investigate. For
example, to examine friction scaling coefficients equal to 0.9, 0.95, and 1.0, at the command
line enter:

mdl = 'DLCReferenceApplication’;
open_system(mdl);

% Define the set of parameters to sweep
lambdamu = [0.9, 0.95, 1.0];
numExperiments = length(lambdamu);

Create an array of simulation inputs that sets Llambdamu equal to the Friction constant block
parameter.
% Create an array of Simulink.SimulationInputs
for idx = numExperiments:-1:1
in(idx) = Simulink.SimulationInput(mdl);
in(idx) = in(idx).setBlockParameter([mdl '/Environment/Friction'], 'Value',['ones(4,1).*",num2str(lambdamu(idx))]
end
Set the simulation stop time at 30 s. Save the model and run the simulations. If available, use
parallel computing.

set param(mdl, 'StopTime', '30")

save_system(mdl)

tic;

simout = parsim(in, 'ShowSimulationManager', 'on');
toc;

Import the simulation results to the Simulation Data Inspector.

a
On the Simulink Editor toolbar, click the Data Inspector button @ .

b In the Simulation Data Inspector, select Import.

_‘ Import

— Import from workspace or file

¢ In the Import dialog box, clear Logsout. Select simout (1), simout(2), and simout(3).
Select Import.
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Import

Import time series data from the base workspace or a file

Import from: (e Base workspace

File

Import to: o New run

Existing run

«| v simout(1)
¥| » simout(2)

¥ » simout(3)

d Select each of the runs. For each run, right-click to rename the run to the friction scaling
coefficient that corresponds to the simulation.

» lambdamu=.9
» lambdamu=.95

lambdamu=1
r

7  Explore the results in the Simulation Data Inspector.

To assess the success of the maneuver test when lambdamu is equal to .9, .95, and 1.0, plot
the upper lane boundary, <UB>, lower lane boundary, <LB>, and lateral vehicle distance, Y.

The results are similar to these plots, which show the results for the runs. The results indicate
that the vehicle lateral position does come close to the lane boundaries.
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M Visualization/Lane:1.UE M Visualization/Lane:1.LE m VehFdbk Body.Y
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+ To assess the yaw stability for the road surfaces, plot the lateral acceleration, ay, lateral
vehicle distance, Y, yaw angle, psi, and yaw rate, r.

The results are similar to these plots. The results indicate that the vehicle has a yaw rate of
about .72 rad/s when the friction scaling coefficient is equal to 1.
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8 To explore the results further, use these commands to extract the lateral acceleration, steering
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angle, and vehicle trajectory from the simout object.

figure
for idx = l:numExperiments

% Extract Data
log = simout(idx).get('logsout');
sa=log.get('Steering-wheel angle').Values;
ay=log.get('Lateral acceleration').Values;

Extract the lateral acceleration and steering angle. Plot the data.

% Plot results from simout object: lateral acceleration vs steering angle
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legend labels{idx} = ['lambdamu = ', num2str(lambdamu(idx))];

% Plot steering angle vs. lateral acceleration
plot(sa.Data,ay.Data)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Lateral Acceleration')
xlabel('Steering Angle [deg]')
ylabel('Acceleration [m/s"2]")
grid on

The results are similar to this plot. They indicate that the greatest lateral acceleration occurs
when the friction scaling coefficient is 1.

Lateral Acceleration
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P
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—E i i i i i i i
-800 -600 =400 -200 0 200 400 600 800

Steering Angle [deqg]
* Extract the vehicle path. Plot the data.

figure
for idx = 1l:numExperiments
% Extract Data
log = simout(idx).get('logsout');
VehFdbk = log.get('VehFdbk');
x = VehFdbk.Values.Body.X;
y = VehFdbk.Values.Body.Y;
legend labels{idx} = ['lambdamu = ', num2str(lambdamu(idx))];

% Plot vehicle location

plot(y.Data,x.Data)
hold on
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end

% Add labels to the plots

legend(legend labels, 'Location', 'best');
title('Vehicle Path'")

xlabel('Y Position [m]"')

ylabel('X Position [m]"')

grid on

The results are similar to this plot. They indicate that the greatest lateral vehicle position
occurs when the friction scaling coefficient is 0. 9.

Vehicle Path
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a
=
[=]
o 100 .
ot
50 .
D - -
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-1.5 -1 0.5 1] 0.5 1 1.5 2 2.5 3 3.5
Y Position [m]
See Also

Simulink.SimulationInput | Simulink.SimulationOQutput

References

[111SO 3888-2: 2011. Passenger cars — Test track for a severe lane-change manoeuvre.
See Also

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-50
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More About
. “Double-Lane Change Maneuver” on page 3-4
. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6

. Simulation Data Inspector
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Vehicle Steering Gain at Different Speeds

1-30

This example shows how to use the vehicle dynamics slowly increasing steering reference application
to analyze the impact of the steering angle and speed on vehicle handling. Specifically, you can
calculate the steering gain when you run the maneuver with different speed set points.

Based on the constant speed, variable steer test defined in SAE J266!, the slowly increasing steering
maneuver helps characterize the lateral dynamics of the vehicle. In the test, the driver:

Accelerates until vehicle hits a target velocity.

Maintains a target velocity.

Linearly increases the steering wheel angle from 0 degrees to a maximum angle.
Maintains the steering wheel angle for a specified time.

Linearly decreases the steering wheel angle from maximum angle to 0 degrees.

For more information about the reference application, see “Slowly Increasing Steering Maneuver” on
page 3-22.

Run a Slowly Increasing Steering Maneuver

1

Create and open a working copy of the increasing steering reference application.

vdynblksIncreasingSteeringStart
Open the Slowly Increasing Steer block. By default, the maneuver is set with these parameters:

* Longitudinal speed setpoint — 50 mph
* Handwheel rate — 13.5 deg
* Maximum handwheel angle — 270 deg

Open the Visualization subsystem. By default, the 3D Engine is set with the 3D visualization
engine disabled. For the 3D visualization engine platform requirements and hardware
recommendations, see “3D Visualization Engine Requirements” on page 1-5.

Run the maneuver with the default settings. As the simulation runs, view vehicle information.

* In the Vehicle Position window, view the vehicle longitudinal distance as a function of lateral
distance.


matlab:vdynblksIncreasingSteeringStart

Vehicle Steering Gain at Different Speeds
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* In the Visualization subsystem, open the Yaw Rate and Steer Scope block to display the yaw
rate and steering angle versus time:

* Yellow line — Yaw rate
* Blue lines — Steering angle

The blue line shows a linearly increasing and decreasing steering angle.
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4| Yaw Rate and Steer — O >
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Sweep Speed Set Points

Run the slowly increasing steering angle reference application with three different speed set points.

1 In the slowly increasing steering reference application model ISReferenceApplication, open
the Slowly Increasing Steer block. The Longitudinal speed set point, xdot_r block parameter
sets the vehicle speed. By default, the speed is 50 mph.

2 In the Visualization subsystem, enable signal logging for these model elements. Disable the 3D
visualization environment. You can use the Simulink editor or, alternatively, MATLAB commands.
Save the model.
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Model Element Simulink Editor
VehFdbk inport

=xdat=

WehFdbk

IS0 15037-1:2006 block Block Parameters: 150 15037-1:2006
ISO 15037-1:2006 (mask)

Enables display of ISO 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters

IS0 Measurements

(®) Enabled

Cﬁ)iﬁabled

Block Pararmeters: 30 Engine

3D Engine block

3D Engine (mask)

This subsystemn contains the intel
display of the vehicle in the 3D vi
the simulation progress, disable i

3D Engine Settings
3D Engine
) Enabled
® l;lgiﬁabled

Alternatively, use these commands to enable the signal logging, disable the 3D visualization
environment, and save the model.
% Open the model

mdl = 'ISReferenceApplication’;
open_system(mdl);

% Enable signal logging for VehFdbk
ph=get param('ISReferenceApplication/Visualization/VehFdbk', 'PortHandles');
set param(ph.Outport, 'DataLogging','on');

% Enable signal logging for ISO block
set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable');

% Disable 3D environment
set param([mdl '/Visualization/3D Engine'], 'engine3D', 'Disabled');
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save system(mdl)

Set up a speed set point vector, xdot r, that you want to investigate. For example, at the
command line, enter:

mdl = 'ISReferenceApplication’;
open_system(mdl);

% Define the set of parameters to sweep
vmax = [40, 50, 60];

tfinal = [60, 60, 60];

numExperiments = length(vmax);

Create an array of simulation inputs that set xdot r equal to the Slowly Increasing Steer block
parameter.

for idx = numExperiments:-1:1

in(idx) = Simulink.SimulationInput(mdl);
in(idx) = in(idx).setBlockParameter([mdl '/Slowly Increasing Steer'], 'xdot r', num2str(vmax(idx)));
in(idx) = in(idx).setModelParameter('StopTime', num2str(tfinal(idx)));

end

Save the model and run the simulations. If available, use parallel computing.
save_system(mdl);

tic;

simout = parsim(in, 'ShowSimulationManager', 'on');

toc;

Import the simulation results to the Simulation Data Inspector.
) %
On the Simulink Editor toolbar, click the Data Inspector button .

b In the Simulation Data Inspector, select Import. In the Import dialog box, accept the
defaults and select Import.

_‘ Import

— Import from workspace or file

¢ In the Import dialog box, clear Logsout. Select simout (1), simout(2), and simout(3).
Select Import.
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Import

Import time series data from the base workspace or a file

Import from: (e Base workspace

File

Import to: o New run

Existing run

«| v simout(1)
¥| » simout(2)

¥ » simout(3)

d  Select each of the runs. For each run, right-click to rename the results to the velocity that
corresponds to the simulation. Run 1 corresponds to the simulation with the default settings.

» Run 1: default [Current]
» Run 2: vel=40
p Run 3: vel=50

Run 4: vel=60

b

Explore the results in the Simulation Data Inspector. To characterize the steering, view the plots
of the simulation results. For example, plot longitudinal velocity, steering wheel angle, lateral
acceleration, longitudinal position, X, and lateral position, Y. The results are similar to these
plots, which show the results for runs 2, 3, and 4. The results indicate that the greatest lateral

acceleration occurs when the vehicle velocity is 40 mph.
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8 To explore the results further, use these commands to extract the lateral acceleration, steering
angle, and vehicle trajectory from the simout object.

» Extract the lateral acceleration and steering angle. Plot the data. To calculate the steering
gain, fit a first order polynomial to the data.
% Plot results from simout object: lateral acceleration vs steering angle

figure
for idx = l:numExperiments
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% Extract Data

log = simout(idx).get('logsout');
sa=log.get('Steering-wheel angle').Values;
ay=log.get('Lateral acceleration').Values;

firstorderfit = polyfit(sa.Data,ay.Data,l);
gain(idx)=firstorderfit(1l);

legend labels{idx} = [num2str(vmax(idx)), ' mph: Gain = ',num2str(gain(idx)),

% Plot steering angle vs. lateral acceleration
plot(sa.Data,ay.Data)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Lateral Acceleration')
xlabel('Steering Angle [deg]')
ylabel('Acceleration [m/s"2]")
grid on

The results are similar to this plot.

' m/(deg s*2)'1;

Lateral Acceleration

Acceleration [mfs‘?]
.

40 mph: Gain = 0.035816 m/{deg 52]-
50 mph: Gain = 0.035119 m/{deg 52}
60 mph: Gain = 0.035045 m/{deg 52}
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Steering Angle [deq]

Extract the vehicle path. Plot the data.

% Plot vehicle path
figure
for idx = 1l:numExperiments
% Extract Data
log = simout(idx).get('logsout');
VehFdbk = log.get('VehFdbk');
x = VehFdbk.Values.Body.X;
y = VehFdbk.Values.Body.Y;

250

300
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legend labels{idx} = [num2str(vmax(idx)), ' mph'];

% Plot vehicle location

axis('equal')

plot(y.Data,x.Data)

hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Vehicle Path'")
xlabel('Y Position [m]"')
ylabel('X Position [m]"')
grid on

The results are similar to this plot.
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References

[1]1 SAE J266. Steady-State Directional Control Test Procedures For Passenger Cars and Light Trucks.
Warrendale, PA: SAE International, 1996.

See Also
Simulink.SimulationInput | Simulink.SimulationOutput | polyfit
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More About
. “Slowly Increasing Steering Maneuver” on page 3-22
. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6

. Simulation Data Inspector
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Vehicle Lateral Acceleration at Different Speeds

1-40

This example shows how to use the vehicle dynamics constant radius reference application to analyze
the impact of speed on the vehicle lateral dynamics. Specifically, you can examine the lateral
acceleration when you run the maneuver with different speeds. For information about similar
maneuvers, see standards SAE J266 199601' and ISO 4138:20122.

During the maneuver, the vehicle uses a predictive driver model to maintain a pre-specified turn
radius at a set velocity.

For more information about the reference application, see “Constant Radius Maneuver” on page 3-
29.

Run a Constant Radius Maneuver

1 Create and open a working copy of the constant radius reference application.

vdynblksConstRadiusStart
2 Select the Reference Generator block. By default, the reference application uses the Predictive
Driver block to maintain a 100 m right turn radius at 30 mph.
* Maneuver — Constant radius
* Use maneuver-specific driver, initial position, and scene — on
* Longitudinal velocity — 35 mph
* Radius value — 100 m

3  Select the Reference Generator block 3D Engine tab. By default, the 3D Engine parameter is

Disabled. For the 3D visualization engine platform requirements and hardware
recommendations, see “3D Visualization Engine Requirements” on page 1-5.

4 Run the maneuver with the default settings. As the simulation runs, view vehicle information.

» In the Vehicle Position window, view the vehicle longitudinal distance as a function of lateral
distance.


matlab:vdynblksConstRadiusStart

Vehicle Lateral Acceleration at Different Speeds
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* In the Visualization subsystem, open the Steer, Velocity, Lat Accel Scope block to display the
steering angle, velocity, and lateral acceleration versus time.
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4. Steer, Velocity, Lat Accel

File  Tools  View  Simulation  Help

G- GOP®| = FF-

Sample based | T=60.000

Ready

Sweep Speed

Run the constant radius reference application with three different speeds. Stop the simulation if the
vehicle exceeds a lateral acceleration threshold of .5 g.

1 In the constant radius reference application model CRReferenceApplication, open the
Reference Generator block. The Longitudinal velocity reference, xdot_r block parameter sets

the vehicle speed. By default, the speed is 30 mph.
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2 Enable signal logging. Select the Reference Generator block Stop simulation at lateral
acceleration threshold parameter. You can use the Simulink editor or, alternatively, MATLAB
commands. Save the model.

Model Element Simulink Editor
Visualization subsystem — '7 =
VehFdbk inport [ m H ]

=xdat=

WehFdbk

Visualization subsystem — Block Parameters: IS0 15037-1:2006
ISO 15037-1:2006 block
ISO 15037-1:2006 (mask)

Enables display of IS0 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters
IS0 Measurements
® Enabled

isabled

Reference Generator block Constant Radius

Radius value, R [m]: | 100

Turn direction | Right

Lateral acceleration threshold, ay_max [g]: |0.5

Stop simulation at lateral acceleration thresheld

Alternatively, use these commands to enable the signal logging and stop the simulation if the
vehicle exceeds a lateral acceleration limit. Save the model.

% Open the model
mdl = 'CRReferenceApplication’;
open_system(mdl);

% Enable signal logging for VehFdbk
ph=get param('CRReferenceApplication/Visualization/VehFdbk', 'PortHandles"');
set param(ph.Outport, 'DataLogging','on');

% Enable signal logging for ISO block
set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable');

% Set parameter to stop simulation at lateral acceleration threshold

set param([mdl '/Reference Generator'],'cr ay stop','on');
save system(mdl)
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3 Setup a speed set point vector, xdot r, that you want to investigate. For example, at the
command line, enter:

mdl = 'CRReferenceApplication';
open_system(mdl);

% Define the set of parameters to sweep
vmax = [35, 40, 45];

tfinal = [60, 60, 60];

numExperiments = length(vmax);

4 Create an array of simulation inputs that set xdot r equal to the Reference Generator block
parameter.

for idx = numExperiments:-1:1

in(idx) = Simulink.SimulationInput(mdl);
in(idx) = in(idx).setBlockParameter([mdl '/Reference Generator'], 'xdot r', num2str(vmax(idx)));
in(idx) = in(idx).setModelParameter('StopTime', num2str(tfinal(idx)));

end

5 Save the model and run the simulations. If available, use parallel computing.

save_system(mdl);

tic;

simout = parsim(in, 'ShowSimulationManager','on');
toc;

6 Import the simulation results to the Simulation Data Inspector.

a
On the Simulink Editor toolbar, click the Data Inspector button @ .

b In the Simulation Data Inspector, select Import. In the Import dialog box, accept the
defaults and select Import.

‘ Import

— Impor from workspace or file

¢ In the Import dialog box, clear Llogsout. Select simout (1), simout(2), and simout(3).
Select Import.

d  Select each of the runs. For each run, right-click to rename the results to the velocity that
corresponds to the simulation.

» vel=40mph}

» vel=asmph

7  Explore the results in the Simulation Data Inspector. To characterize the lateral acceleration and
steering, view the plots of the simulation results. For example, plot longitudinal velocity, lateral
acceleration, and the steering wheel angle. The results are similar to these plots, which show the
results for the three runs. The results indicate that the greatest lateral acceleration occurs when
the vehicle velocity is 45 mph.
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8 To explore the results further, use these commands to extract the lateral acceleration, steering
angle, and vehicle trajectory from the simout object.

* Extract the lateral acceleration and steering angle. Plot the data. To calculate the steering
gain, fit a first order polynomial to the data.

% Plot results from simout object: lateral acceleration vs steering angle

figure

for idx = l:numExperiments

% Extract Data
log = simout(idx).get('logsout');

sa=log.get('Steering-wheel angle').Values;
ay=log.get('Lateral acceleration').Values;

firstorderfit

gain(idx)=firstorderfit(1l);

polyfit(sa.Data,ay.Data,l);
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legend labels{idx} = [num2str(vmax(idx)), ' mph: Gain = ',num2str(gain(idx)), ' m/(deg s"2)'];
% Plot steering angle vs. lateral acceleration
plot(sa.Data,ay.Data)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Lateral Acceleration');
xlabel('Steering Angle [deg]');
ylabel('Acceleration [m/s”2]1");
grid on;
The results are similar to this plot.
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Extract the vehicle path. Plot the data.

% Plot vehicle path
figure
for idx = 1l:numExperiments
% Extract Data
log = simout(idx).get('logsout');
VehFdbk = log.get('VehFdbk');
x = VehFdbk.Values.Body.X;
y = VehFdbk.Values.Body.Y;
legend labels{idx} = [num2str(vmax(idx)),

mph'];

% Plot vehicle location
axis('equal')
plot(y.Data,x.Data)
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hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Vehicle Path'")
xlabel('Y Position [m]"')
ylabel('X Position [m]"')
grid on

The results are similar to this plot.

Vehicle Path
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35 mph
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References

[11]266 199601. Steady-State Directional Control Test Procedures for Passenger Cars and Light
Trucks. Warrendale, PA: SAE International, 1996.

[2]1 ISO 4138:2012. Passenger cars -- Steady-state circular driving behaviour -- Open-loop test
methods. ISO (International Organization for Standardization), 2012.

See Also
Simulink.SimulationInput |Simulink.SimulationOutput | polyfit

More About

. “Constant Radius Maneuver” on page 3-29
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. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6
. Simulation Data Inspector
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Frequency Response to Steering Angle Input

This example shows how to use the vehicle dynamics swept-sine steering reference application to
analyze the dynamic steering response to steering inputs. Specifically, you can examine the vehicle
frequency response and lateral acceleration when you run the maneuver with different sinusoidal
wave steering amplitudes.

The swept-sine steering maneuver tests the vehicle frequency response to steering inputs. In the test,
the driver:

* Accelerates until the vehicle hits a target velocity.

* Commands a sinusoidal steering wheel input.

» Linearly increase the frequency of the sinusoidal wave.

For more information about the reference application, see “Swept-Sine Steering Maneuver” on page
3-15.

Run a Swept-Sine Steering Maneuver

1 Create and open a working copy of the increasing steering reference application.

vdynblksSweptSineSteeringStart
2  Open the Swept Sine Reference Generator block. By default, the maneuver is set with these
parameters:
* Longitudinal velocity setpoint — 30 mph
* Steering amplitude — 90 deg
* Final frequency — 0.7 Hz

3 Open the Visualization subsystem. By default, the 3D Engine is set with the 3D visualization
engine disabled. For the 3D visualization engine platform requirements and hardware
recommendations, see “3D Visualization Engine Requirements” on page 1-5.

4 Run the maneuver with the default settings. As the simulation runs, view vehicle information.

* In the Vehicle Position window, view the vehicle longitudinal distance as a function of lateral
distance.
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* In the Visualization subsystem, open the Yaw Rate and Steer Scope block to display the yaw
rate and steering angle versus time:

*  Yellow line — Yaw rate
* Blue lines — Steering angle

The blue line shows a 90 deg amplitude sinusoidal steering angle with an increasing
frequency.
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4. Yaw Rate and Steer — | *
File  Tools  View  Simulation  Help u
@-10OP® == a- |0 FF-

Steerfngle

Ready Sample based (T=40.000

Sweep Steering

Run the reference application with three different sinusoidal wave steering amplitudes.

1 In the swept-sine steering reference application model SSSReferenceApplication, open the
Swept Sine Reference Generator block. The Steering amplitude, theta_hw block parameter
sets the amplitude. By default, the amplitude is 90 deg.

2 In the Visualization subsystem, enable signal logging for these model elements. Disable the 3D
visualization environment. You can use the Simulink editor or, alternatively, MATLAB commands.
Save the model.
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Model Element

Simulink Editor

VehFdbk inport

=xdat=

WehFdbk

ISO 15037-1:2006 block

Block Parameters: |50 13037-1:2006
IS0 15037-1:2006 (mask)

Enables display of ISO 15037-1:2006 standard measurement
signals in the Simulation Data Inspector.

Parameters
IS0 Measurements

(®) Enabled

Cﬁ)iﬁabled

3D Engine block

Block Pararmeters: 30 Engine
3D Engine (mask)

This subsystemn contains the intel
display of the vehicle in the 3D vi
the simulation progress, disable i

3D Engine Settings
3D Engine
) Enabled
® l;lgiﬁabled

Alternatively, use these commands to enable the signal logging, disable the 3D visualization

environment, and save the model.

% Open the model

mdl = 'SSSReferenceApplication’;

open_system(mdl);

% Enable signal logging for VehFdbk
ph=get param('SSSReferenceApplication/Visualization/VehFdbk', 'PortHandles"');
set param(ph.Qutport, 'DataLogging','on');

% Enable signal logging for ISO block
set param([mdl '/Visualization/ISO 15037-1:2006'], 'Measurement', 'Enable');
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% Disable 3D environment
set param([mdl '/Visualization/3D Engine'], 'engine3D', 'Disabled"');

save_system(mdl)

Set up a steering amplitude vector, amp, that you want to investigate. For example, at the
command line, type:

mdl = 'SSSReferenceApplication';

open_system(mdl);

% Define the set of amplitudes to sweep

amp = [60, 90, 120];

numExperiments = length(amp);

Create an array of simulation inputs that set the Swept Sine Reference Generator block
parameter Steering amplitude, theta_hw equal amp.

for idx = numExperiments:-1:1

in(idx) = Simulink.SimulationInput(mdl);

in(idx) = in(idx).setBlockParameter([mdl '/Swept Sine Reference Generator'], 'theta hw',nt
end

Save the model and run the simulations. If available, use parallel computing.
tic;

simout = parsim(in, 'ShowSimulationManager','on');

toc;

Import the simulation results to the Simulation Data Inspector.

a
On the Simulink Editor toolbar, click the Data Inspector button @ .

b In the Simulation Data Inspector, select Import. In the Import dialog box, accept the
defaults and select Import.

" Import

— Import from workspace or file

¢ In the Import dialog box, clear logsout. Select simout (1), simout(2), and simout(3).
Select Import.
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Import

Import time series data from the base workspace or a file

Import from: (e Base workspace

File

Import to: o New run

Existing run

W ogou
«| v simout(1)
¥| » simout(2)

¥ » simout(3)

d  Select each of the runs. For each run, right-click to rename the results to the amplitude that
corresponds to the simulation. Run 1 corresponds to the simulation with the default settings.
» Run 1: default [Current]
» Run 2: amp=60
» Run 3: amp=00

Run 4: amp=120

7  Explore the results in the Simulation Data Inspector. To characterize the steering, view the plots
of the simulation results. For example, plot lateral position, Y, steering wheel angle, and lateral
acceleration. The results are similar to these plots, which show the results for runs 2, 3, and 4.
The results indicate that the greatest lateral acceleration occurs when the steering amplitude is
120 deg.
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8 To explore the results further, use these commands to extract the lateral acceleration, steering

angle, and vehicle trajectory from the simout object.
» Extract the lateral acceleration and steering angle. Plot the data.

% Plot results from simout object: lateral acceleration vs steering angle
figure
for idx = l:numExperiments

% Extract Data

log = simout(idx).get('logsout');

sa=log.get('Steering-wheel angle').Values;

ay=log.get('Lateral acceleration').Values;

legend labels{idx} = ['amplitude = ', num2str(amp(idx)), '~{\circ}'];
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% Plot steering angle vs. lateral acceleration

plot(sa.Data,ay.Data)

hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Lateral Acceleration')
xlabel('Steering Angle [deg]')
ylabel('Acceleration [m/s”2]")
grid on

The results are similar to this plot.

Lateral Acceleration
E T T T

M
T

Acceleration [m;"s‘?]
[ =

L

amplitude = 60
amplitude = 90~
amplitude = 120

—\E i i
-150 -100 -50 0 50

Steering Angle [deqg]
Extract the vehicle path. Plot the data.

% Plot results from simout object
figure
for idx = l:numExperiments
% Extract Data
log = simout(idx).get('logsout');
VehFdbk = log.get('VehFdbk"');
x = VehFdbk.Values.Body.X;
y = VehFdbk.Values.Body.Y;

100

legend labels{idx} = ['amplitude = ', num2str(amp(idx)),

% Plot vehicle location
axis('equal')

150

'~{\circ}'];
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plot(y.Data,x.Data)
hold on
end
% Add labels to the plots
legend(legend labels, 'Location', 'best');
title('Vehicle Path'")
xlabel('Y Position [m]"')
ylabel('X Position [m]")
grid on

The results are similar to this plot.

Vehicle Path
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9 For the next steps, use a fast Fourier transform (FFT) to examine the steering response in the
frequency domain.

See Also
Simulink.SimulationInput | Simulink.SimulationQutput | fft

More About

. “Fourier Analysis and Filtering” (MATLAB)

. Simulation Data Inspector

. “Swept-Sine Steering Maneuver” on page 3-15

. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6
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Coordinate Systems in Vehicle Dynamics Blockset

Vehicle Dynamics Blockset uses these coordinate systems to calculate the vehicle dynamics and
position objects in the 3D visualization environment.

Environment

Description

Coordinate Systems

Vehicle dynamics
in Simulink

The right-hand rule establishes the X-Y-Z
sequence and rotation of the coordinate axes
used to calculate the vehicle dynamics. The
Vehicle Dynamics Blockset 3D simulation
environment uses these right-handed (RH)
Cartesian coordinate systems defined in the SAE
J670%1 and ISO 88558! standards:

e Earth-fixed (inertial)

* Vehicle

* Tire

*  Wheel

The coordinate systems can have either
orientation:

* Z-down — Defined in SAE J670[!
¢ Z-up — Defined in SAE J670(2 and ISO 8855!3!

“Earth-Fixed (Inertial)
Coordinate System” on page 2-
2

“Vehicle Coordinate System” on
page 2-3

“Tire and Wheel Coordinate
Systems” on page 2-3

3D visualization
engine

To position objects and query the 3D visualization
environment, the Vehicle Dynamics Blockset uses
a world coordinate system.

“World Coordinate System” on
page 2-5

Earth-Fixed (Inertial) Coordinate System

The earth-fixed coordinate system (Xg, Yz, Zr) axes are fixed in an inertial reference frame. The
inertial reference frame has zero linear and angular acceleration and zero angular velocity. In
Newtonian physics, the earth is an inertial reference.

2-2
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Axis Description

Xz The X axis is in the forward direction of the vehicle.

Yz The X and Yy axes are parallel to the ground plane. The ground plane is a
horizontal plane normal to the gravitational vector.

Zy In the Z-up orientation, the positive Z; axis points upward.

In the Z-down orientation, the positive Z; axis points downward.

Vehicle Coordinate System

The vehicle coordinate system axes (Xy, Yy, Zy) are fixed in a reference frame attached to the vehicle.
The origin is at the vehicle sprung mass.

Z-Down Orientation

1l Yaw
b
zZ,
Axis Description
Xy The Xy, axis points forward and is parallel to the vehicle plane of symmetry.
Yy The Yy, axis is perpendicular to the vehicle plane of symmetry.
Zy In the Z-down orientation:

* Yy axis points to the right

* Zyaxis points downward

Tire and Wheel Coordinate Systems

The tire coordinate system axes (X1, Yy, Z7) are fixed in a reference frame attached to the tire. The
origin is at the tire contact with the ground.

The wheel coordinate system axes (X, Yy, Zy) are fixed in a reference frame attached to the wheel.
The origin is at the wheel center.

Z-Up Orientation’
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Positive "-_‘._!'_“ Tire
Inclination| . Trajectory
Angle Velocity Xy

~
Wheel Plane . Direction of
Y Positive Wheel Heading
T Slip Angle
Wheel
Road Flane Spin Axis
/1
Z-Down Orientation
Direction of
"™~ Positive Wheel Heading
© | Inclination Angle X
Wheel ! x
. SpinAxis | Wneel Fiane
N Tire
Trajectory
™ - f\- -¥ Welocity
= Paositive
Slip Angle
Foad Flane
Yl\'
YT
Z
Xr Xr and Y are parallel to the road plane. The intersection of the wheel plane and
Yy the road plane define the orientation of the X axis.
Zr Z7 points:
¢ Upward in the Z-up orientation
¢ Downward in the Z-down orientation
Xw Xy and Yy, are parallel to the wheel plane:

Reprinted with permission Copyright © 2008 SAE International. Further distribution of this material is not permitted
without prior permission from SAE.
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Axis Description
Yo * Xy is parallel to the local road plane.
* Yy is parallel to the wheel-spin axis.

Zw Zy points:

* Upward in the Z-up orientation
* Downward in the Z-down orientation

World Coordinate System

The 3D visualization environment uses a world coordinate system with axes that are fixed in the
inertial reference frame.

Z

Yaw

<O Rl oy

R

Axis Description
X Forward direction of the vehicle

Roll — Right-handed rotation about X-axis
Y Extends to the right of the vehicle, parallel to the ground plane

Pitch — Right-handed rotation about Y-axis
Z Extends upwards

Yaw — Left-handed rotation about Z-axis

References

[1] Gillespie, Thomas. Fundamentals of Vehicle Dynamics. Warrendale, PA: Society of Automotive
Engineers, 1992.

[2] Vehicle Dynamics Standards Committee. Vehicle Dynamics Terminology. SAE J670. Warrendale,
PA: Society of Automotive Engineers, 2008.

[3] Technical Committee. Road vehicles — Vehicle dynamics and road-holding ability — Vocabulary.
ISO 8855:2011. Geneva, Switzerland: International Organization for Standardization, 2011.
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See Also

More About

. “Coordinate Systems in Automated Driving Toolbox” (Automated Driving Toolbox)

External Websites

. SAE International Standards
. ISO Standards
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Passenger Vehicle Dynamics Models

3-2

To analyze the dynamic system response in common ride and handling maneuvers, Vehicle Dynamics

Blockset provides these pre-assembled vehicle dynamics models.

Vehicle |Description |Vehicle Body Degrees-of-Freedom Wheel DOFs
Model (DOFs)
Passenger|e Vehicle Six Two per wheel - eight total
14DOF with four
Vehicle wheels Translational Rotational Translational |Rotational
¢ Available as || Longitudinal v |Pitch v Vertical v |Rolling | v
mo‘,iel ) Lateral v  |Yaw v
variant in
the Vertical v [Roll 4
maneuver
reference
applications
Passenger|* Vehicle Three One per wheel - four total
7DOF with four
Vehicle wheels Translational Rotational Rotational
* Available as || Longitudinal v |Pitch Rolling v
model Lateral v |Yaw
variant in -
the Vertical Roll
maneuver
reference
applications
Passenger|e Vehicle Three None
3DOF with ideal
Vehicle tire Translational Rotational
Longitudinal v |Pitch
Lateral v |Yaw
Vertical Roll

From the Simulink start page, you can open project files that contain the vehicle models.




Passenger Vehicle Dynamics Models

4 Simulink Start Page — ]
New Examples
3 Open.. All Templates  w
Recent
P2 mymodel six > System Composer

i v \ehicle Dynamics Blockset
Projects

i@ From Source Control «

Passenger 3DOF Vehicle Passenger TDOF Vehicle

See Also
Vehicle Body 3DOF | Vehicle Body 6DOF

More About
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. “Vehicle Reference Applications”
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Double-Lane Change Maneuver

3-4

This reference application represents a full vehicle dynamics model undergoing a double-lane change
maneuver according to standard ISO 3888-2[!1. You can create your own versions, establishing a
framework to test that your vehicle meets the design requirements under normal and extreme driving
conditions. Use the reference application to analyze vehicle ride and handling and develop chassis
controls. To perform vehicle studies, including yaw stability and lateral acceleration limits, use this
reference application.

ISO 3888-2! defines the double-lane change maneuver to test the obstacle avoidance performance of
a vehicle. In the test, the driver:

* Accelerates until vehicle hits a target velocity

* Releases the accelerator pedal

* Turns steering wheel to follow path into the left lane

» Turns steering wheel to follow path back into the right lane

Typically, cones mark the lane boundaries. If the vehicle and driver can negotiate the maneuver
without hitting a cone, the vehicle passes the test.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine
platform requirements and hardware recommendations, see “3D Visualization Engine Requirements”
on page 1-5.

To create and open a working copy of the double-lane change reference application project, enter
vdynblksDblLaneChangeStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element
Lane Change Reference |Generates lane signals for the visualization subsystem and
Generator trajectory signals for the Predictive Driver block
Predictive Driver Generates normalized steering, acceleration, and braking
commands that track the reference trajectory
Environment Implements wind and ground forces v
Controllers Implements controllers for engine control units (ECUs), v
transmissions, and brakes
Passenger Vehicle Implements the: v
* Engine
» Steering, transmission, driveline, and brakes
* Body, suspension, and wheels
Visualization Provides the vehicle trajectory, driver response, and 3D v

visualization
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Double-Lane Change Maneuver

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.

Lane Change Reference Generator

Use the Lane Change Reference Generator block to generate:

* Lane signals for the Visualization subsystem — The left and right lane boundaries are a function of
the Vehicle width parameter.

* Velocity and lateral reference signals for the Predictive Driver block — Use the Lateral reference
position breakpoints and Lateral reference data parameters to specify the lateral reference
trajectory as a function of the longitudinal distance.

To specify the target velocity, use the Longitudinal entrance velocity setpoint parameter.

Predictive Driver

The reference application uses the Predictive Driver block to generate normalized steering,
acceleration, and braking commands that track the reference trajectory.

The Predictive Driver block implements an optimal single-point preview (look ahead) control model

developed by C. C. MacAdam!?! 31 14, The model represents driver steering control behavior during
path-following and obstacle avoidance maneuvers. Drivers preview to follow a predefined path.

Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description

Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment

Constant (default) [Implements a constant friction value

Controllers

The Controllers subsystem generates engine torque, transmission gear, and brake commands. The
reference application has these brake variants.

Controller Variant Description

Brake Pressure Control Bang Bang ABS Anti-lock braking system (ABS) feedback
controller that switches between two states

Open Loop Open loop braking controller
(default)
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Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.

Subsystem

Driveline, and Brakes

Body, Suspension, Variant Description
Wheels Subsystem
PassVeh7DOF PassVeh7DOF Vehicle with four wheels:
(default) .
* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw
* Each wheel has one DOF — Rolling
PassVeh14DOF PassVeh14DOF Vehicle with four wheels.
* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll
* Each wheel has two DOFs — Vertical and
rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)
Steering, Transmission, |Variant Description

Driveline |Driveline
Ideal Fixed |model
Gear

All Wheel Drive

Front Wheel
Drive

Rear Wheel Drive
(default)

Configure the driveline for all-wheel, front-wheel,
or rear-wheel drive

Specify the type of torque coupling

Transmission

Ideal (default)

Ideal fixed gear transmission

Visualization

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.
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U
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Lane Changa
<
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WehFdbk - otz o D
<HY> .
Steer, Velocity, Lat Accel
| VehFdbk
WehFdbk
Vehicle XY Plotter
-
3D Engine
Disabled
| VehFdbk
IS0 15037-1:2006
= it
IS0 15037-1: 2006
Disablad
Element Description

Driver Commands

Driver commands:

* Handwheel angle
¢ Acceleration command
¢ Brake command

Vehicle Response

Vehicle response:

* Engine speed
* Vehicle speed
¢ Acceleration command
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Element

Description

Lane Change Scope block

Lateral vehicle displacement versus time:

* Red line — Cones marking lane boundary
* Blue line — Reference trajectory
* Green line — Actual trajectory

Steer vs Ay Scope block

Steering angle versus lateral acceleration

Steer, Velocity, Lat Accel

* SteerAngle — Steering angle versus time

Scope block + <xdot> — Longitudinal vehicle velocity versus time
* <ay> — Lateral acceleration versus time
Vehicle XY Plotter Vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block

Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

3D Visualization

Optionally, you can enable or disable the 3D visualization environment. For the 3D visualization
engine platform requirements and hardware recommendations, see “3D Visualization Engine
Requirements” on page 1-5. After you open the reference application, in the Visualization subsystem,
open the 3D Engine block. Set these parameters.

* 3D Engine to Enabled.

* Scene to one of the scenes, for example Straight road.

3D Engine
(O Enabled
(®) Disabled

Scene;

Engine

Initial Parking lot

Open surface

L= -

Double lane change

Double lane change

* To position the vehicle in the scene:

1 Select the position initialization method:

* Recommended for scene — Set the initial vehicle position to values recommended for

the scene

* User-specified — Set your own initial vehicle position
Select Apply to modify the initial vehicle position parameters.

Click Update the model workspaces with the initial values to overwrite the initial vehicle
position in the model workspaces with the applied values.

When you run the simulation, view the vehicle response in the AutoVrt1lEnv window.
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Note

* To open and close the AutoVrt1lEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrt1lEnv window, Simulink stops the simulation with an error.

* When you enable the 3D visualization environment, you cannot step the simulation back.

To change the camera views, use these key commands.

Key Camera View
Back left
2 Back

Back
right

Left
Internal
Right
Front left
Front

w

O[O0 || O] &

Front
right

0 Overhead

References
[1]1ISO 3888-2: 2011. Passenger cars — Test track for a severe lane-change manoeuvre.

[2] MacAdam, C. C. "An Optimal Preview Control for Linear Systems". Journal of Dynamic Systems,
Measurement, and Control. Vol. 102, Number 3, 1980.

[3] MacAdam, C. C. "Application of an Optimal Preview Control for Simulation of Closed-Loop
Automobile Driving ". IEEE Transactions on Systems, Man, and Cybernetics. Vol. 11, Number
6, 1981.

[4] MacAdam, C. C. "Development of Driver/Vehicle Steering Interaction Models for Dynamic
Analysis". Final Technical Report UMTRI-88-53. The University of Michigan Transportation
Research Institute. 1988.

See Also
3D Engine | Mapped SI Engine | Predictive Driver | Vehicle Terrain Sensor
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Related Examples

“Send and Receive Double-Lane Change Scene Data” on page 3-50
“Yaw Stability on Varying Road Surfaces” on page 1-18

More About

“3D Visualization Engine Requirements” on page 1-5

“Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
“ISO 15037-1:2006 Standard Measurement Signals” on page 5-2
“Passenger Vehicle Dynamics Models” on page 3-2

“Send and Receive Double-Lane Change Scene Data” on page 3-50
Simulation Data Inspector



Scene Interrogation in 3D Environment

Scene Interrogation in 3D Environment

The scene interrogation with camera and ray tracing reference application provides the Simulink
interface with the 3D visualization environment. For the minimum hardware required to run the
reference application, see “3D Visualization Engine Requirements” on page 1-5.

The scene interrogation with camera and ray tracing reference application contains:

* One passenger vehicle with a simple driveline and a 3DOF vehicle dynamics model.
* One camera mounted on the passenger vehicle rearview mirror.

» Steering, acceleration, and braking control dials.

» 3D visualization environment configured for the Virtual Mcity scene.

Create and open a working copy of the camera and ray tracing reference application project.

vdynblksSceneCameraRayStart

Controls o M Dynamics and Controls Displays
.
-30 30
i |
R —{sD
- - < LS o
l:'_’ HidWhi FroVi A N
Gear:Value 1 ! Info ki - —_
-60 60 Bioar »| WhiingF 7 \ == .___f—} 3]
> ! i xdot-e—] A
. Steering = | aw
-80 an LAeEs, Sl |' ' yelot [-—] | E==
Acgy
O o e =
T S =
N T R T R AT
R v I 1 =pbs
- "‘ Tiarva - ehFdbk RearF FwR l
Accelerator:vValue /s FzR |-+ Y
O O T T AT Powertrain & Driveline Vehicle Body 3D0OF Dual Track Help
0. 4 0 0.
BrakeValue
Simulation 3D Scene Configuration
Sensors
Translation - Translation
Ratation # Rotation
Scale ) Scale
Simulation 30 Actor Transform Get TransformDisplay
Simulation 3D Camera Get ImageDisplay

When you run the simulation, the reference application provides this vehicle and scene information.
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Window Description
AutoVrtlEnv |Video output of the Unreal Engine 3D visualization environment image feedback. By
default, the display shows the view from the Simulation 3D Scene Configuration block
Scene view parameter SimulinkVehiclel.
To change the camera views, use these key commands.
Key Camera View
1 Back
left 8
2 Back E]
7 — — 9
3 Back [ = Peal
right l /
4 Left
5 Internal - L
6 Right | 40Eq— <~ i 6
7 Front
left
8 Front mﬂ / T \ ﬂr
1 3
9 Front
right ra
0 Overhea '
d 2
SDL Video |Video image output of Simulation 3D Camera Get block. By default, the display shows
Display the view specified by these parameter settings:
* Vehicle name — SimulinkVehiclel
* Vehicle mounting location — Rearview mirror
This table summarizes the parts of the reference application.
Name Description
Controls Dials and gauges that control the vehicle steering, gear, acceleration, and braking.
Sensors The Simulation 3D Actor Transform Get block returns the translation, rotation, and
scale for the vehicle passenger vehicle and four wheels from the 3D visualization
environment.
The Simulation 3D Camera Get block returns the camera image from the 3D
visualization environment. By default, the block returns image data for a camera
location specified by these parameter settings:
* Vehicle name — SimulinkVehiclel
* Vehicle mounting location — Rearview mirror
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Scene Interrogation in 3D Environment

Name Description

Dynamics Interfaces with Simulink to calculate the dynamic response of the vehicle plant and
and Controls |controller. By default, the subsystem contains a simple driveline and the Vehicle 3DOF
Dual Track block vehicle dynamics model.

Displays The Simulation 3D Vehicle with Ground Following block implements a passenger
vehicle in the 3D visualization environment. The block uses the vehicle position to
adjust the vehicle elevation, roll, and pitch so that the vehicle follows the ground
terrain. By default, the block has these parameter settings:

* Type — Muscle car

* Color — Red

* Name — SimulinkVehiclel

The Simulation 3D Scene Configuration block configures the Unreal Engine 3D
visualization environment. By default, the block has these parameter settings:

* Scene name — Virtual Mcity
* Scene view — SimulinkVehiclel

The TransformDisplay subsystem displays the translation, rotation, and scale of the
SimulinkVehiclel vehicle body and four wheels.

The ImageDisplay subsystem displays the video image output of Simulation 3D
Camera Get block in the SDL Video Display window.

Displays Subsystems
TransformDisplay Subsystem

In the TransformDisplay subsystem, the Display block provides the translation, rotation, and scale of
the vehicle body and four wheels. Use the Constant block value to control the display.

* 1 — Translation
e 2 — Rotation
e 3 — Scale

For example, to display translation information, set the value to 1.

Displays
)t
\ -212.5| 65.66)| 0.0112]
) —» | of o] 9
Translate = ]KEB] ‘ OH OH 0|
®[5x3] o2, [E1]] o 0| 0|
Rotate [5x31 ‘ 0 ‘ | 0| ‘ O|
: [5x3] *
3 > ]
[5x3]
Scale —
Multiport
Switch
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The display indicates that the:

* Vehicle body is at -212.5 m, 65.66 m, and 0.0112 m along the world X-, Y-, and Z- axes,
respectively.

* Wheels are at their initial positions along the world X-, Y-, and Z- axes, respectively.

The Display block provides an array of the vehicle and wheel locations.

Vehiclex Vehicley Vehicley
FrontLefty FrontLefty FrontLefty
FrontRighty FrontRighty FrontRighty
RearLefty RearLefty RearLefty
RearReary RearReary RearReary

* Vehicle translation and rotation are along the world coordinate system axes.

* Wheel translations and rotations are with respect to their initial positions, along the world
coordinate system axes.

ImageDisplay Subsystem

In the ImageDisplay subsystem, the Level-2 MATLAB S-Function block uses the
VideoDisplayMSfcnWin function to display the video image output of Simulation 3D Camera Get
block.

See Also

Simulation 3D Actor Transform Get | Simulation 3D Camera Get | Simulation 3D Scene Configuration
| Simulation 3D Vehicle with Ground Following | Virtual Mcity

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-50

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

. “Support Package for Customizing Scenes” on page 6-3

. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6

External Websites
. Unreal Engine


https://www.unrealengine.com/en-US/what-is-unreal-engine-4

Swept-Sine Steering Maneuver

Swept-Sine Steering Maneuver

This reference application represents a full vehicle dynamics model undergoing a swept-sine steering
maneuver. You can create your own versions, providing a framework to test that your vehicle meets
the design requirements under normal and extreme driving conditions. Use the reference application
to analyze vehicle ride and handling and develop chassis controls. To analyze the dynamic steering
response, use this reference application.

The swept-sine steering maneuver tests the vehicle frequency response to steering inputs. In the test,
the driver:

* Accelerates until the vehicle hits a target velocity.

* Commands a sinusoidal steering wheel input.

* Linearly increase the frequency of the sinusoidal wave.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine

platform requirements and hardware recommendations, see “3D Visualization Engine Requirements”
on page 1-5.

To create and open a working copy of the swept-sine steering reference application project, enter
vdynblksSweptSineSteeringStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants

Element

Swept Sine Reference |Generate the sinusoidal steering commands for a swept-sine

Generator block steering maneuver.

Longitudinal Driver Generates normalized acceleration and braking commands to

block track speed.

Environment Implements wind and road forces. v

Controllers Implements controllers for engine control units (ECUs), v
transmissions, and brakes.

Passenger Vehicle Implements the: v
* Body, suspension, and wheels
* Engine
* Steering, transmission, driveline, and brakes

Visualization Provides the vehicle trajectory, driver response, and 3D v
visualization.

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.
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Swept Sine Reference Generator

Use the Swept Sine Reference block to generate the sinusoidal steering commands for a swept-sine
steering maneuver.

* Longitudinal velocity setpoint — Target velocity

* Steering amplitude — Sinusoidal wave amplitude

* Final frequency — Cut off frequency to stop the maneuver

Longitudinal Driver
To track the vehicle speed, the Longitudinal Driver block implements an optimal single-point preview
(look ahead) control model developed by C. C. MacAdam! % 3, The model represents driver steering

control behavior during path-following and obstacle avoidance maneuvers. Drivers preview (look
ahead) to follow a predefined path.

Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description

Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment

Constant (default) [Implements a constant friction value

Controllers

The Controllers subsystem generates engine torque, transmission gear, and brake commands. The
reference application has these brake variants.

Controller Variant Description

Brake Pressure Control Bang Bang ABS Anti-lock braking system (ABS) feedback
controller that switches between two states

Open Loop Open loop braking controller
(default)

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.




Swept-Sine Steering Maneuver

Body, Suspension, Variant Description

Wheels Subsystem

PassVeh7DOF PassVeh7DOF Vehicle with four wheels:
(default)

* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw

* Each wheel has one DOF — Rolling
PassVeh14DOF PassVeh14DOF Vehicle with four wheels.

* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll

¢ Each wheel has two DOFs — Vertical and

rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)
Steering, Transmission, |Variant Description
Driveline, and Brakes
Subsystem
Driveline |Driveline All Wheel Drive |Configure the driveline for all-wheel, front-wheel,
Ideal Fixed |[model Front Wheel or rear-wheel drive
Gear Drive
Specify the type of torque coupling
Rear Wheel Drive
(default)
Transmission |Ideal (default) Ideal fixed gear transmission

Visualization Subsystem

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.
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IS0 15037-1:2006
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130 15037-1:2006
Disabled
Element Description

Driver Commands

Driver commands:

* Handwheel angle
¢ Acceleration command
¢ Brake command

Vehicle Response

Vehicle response:

* Engine speed
* Vehicle speed
¢ Acceleration command

Yaw Rate and Steer Scope
block

Yaw rate and steering angle versus time:

* Yellow line — Yaw rate
* Blue lines — Steering angle

Steer vs Ay Scope block

Steering angle versus lateral acceleration




Swept-Sine Steering Maneuver

Element

Description

Steer, Velocity, Lat Accel
Scope block

* SteerAngle — Steering angle versus time
* <xdot> — Longitudinal vehicle velocity versus time
* <ay> — Lateral acceleration versus time

Vehicle XY Plotter

Plot of vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block

Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

3D Visualization

Optionally, you can enable or disable the 3D visualization environment. For the 3D visualization
engine platform requirements and hardware recommendations, see “3D Visualization Engine

Requirements” on page 1-5. After you open the reference application, in the Visualization subsystem,
open the 3D Engine block. Set these parameters.

* 3D Engine to Enabled.

* Scene to one of the scenes, for example Straight road.

3D Engine
) Enabled
(®) Disabled

Engine | curved road
Initial Parking lot

P N

Double lane change
Open surface

» To position the vehicle in the scene:

1  Select the position initialization method:

* Recommended for scene — Set the initial vehicle position to values recommended for

the scene

* User-specified — Set your own initial vehicle position
2 Select Apply to modify the initial vehicle position parameters.

3 Click Update the model workspaces with the initial values to overwrite the initial vehicle
position in the model workspaces with the applied values.

When you run the simulation, view the vehicle response in the AutoVrt1lEnv window.

Note

* To open and close the AutoVrt1lEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrtlEnv window, Simulink stops the simulation with an error.
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*  When you enable the 3D visualization environment, you cannot step the simulation back.

To change the camera views, use these key commands.

Key Camera View

Back left

2 Back

w

Back
right

Left

Internal
Right
Front left
Front

O[O0 || O &

Front
right

0 Overhead

References

[1] MacAdam, C. C. "An Optimal Preview Control for Linear Systems". Journal of Dynamic Systems,
Measurement, and Control. Vol. 102, Number 3, Sept. 1980.

[2] MacAdam, C. C. "Application of an Optimal Preview Control for Simulation of Closed-Loop
Automobile Driving ". IEEE Transactions on Systems, Man, and Cybernetics. Vol. 11, Issue 6,
June 1981.

[3] MacAdam, C. C. Development of Driver/Vehicle Steering Interaction Models for Dynamic Analysis.
Final Technical Report UMTRI-88-53. Ann Arbor, Michigan: The University of Michigan
Transportation Research Institute, Dec. 1988.

See Also
3D Engine | Longitudinal Driver | Mapped SI Engine | Vehicle Terrain Sensor

Related Examples
. “Frequency Response to Steering Angle Input” on page 1-49

More About
. “3D Visualization Engine Requirements” on page 1-5
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2



Swept-Sine Steering Maneuver

“ISO 15037-1:2006 Standard Measurement Signals” on page 5-2
“Passenger Vehicle Dynamics Models” on page 3-2
Simulation Data Inspector
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Slowly Increasing Steering Maneuver

This reference application represents a full vehicle dynamics model undergoing a slowly increasing
steering maneuver according to standard SAE J266!!. You can create your own versions, establishing
a framework to test that your vehicle meets the design requirements under normal and extreme
driving conditions. Use the reference application to analyze vehicle ride and handling and develop
chassis controls. To characterize the steering and lateral vehicle dynamics, use this reference
application.

Based on the constant speed, variable steer test defined in SAE J266!, the slowly increasing steering

maneuver helps characterize the lateral dynamics of the vehicle. In the test, the driver:

* Accelerates until vehicle hits a target velocity.

* Maintains a target velocity.

* Linearly increases the steering wheel angle from 0 degrees to a maximum angle.

* Maintains the steering wheel angle for a specified time.

» Linearly decreases the steering wheel angle from maximum angle to O degrees.

To test advanced driver assistance systems (ADAS) and automated driving (AD) perception, planning,
and control software, you can run the maneuver in a 3D environment. For the 3D visualization engine

platform requirements and hardware recommendations, see “3D Visualization Engine Requirements”
on page 1-5.

To create and open a working copy of the increasing steering reference application project, enter
vdynblksIncreasingSteeringStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element

Slowly Increasing Steer |Generates steering, accelerator, and brake commands for the

block Longitudinal Driver block

Longitudinal Driver Generates normalized acceleration and braking commands to

block track speed

Environment Implements wind and road forces. v
Controllers Implements controllers for engine control units (ECUs), v

transmissions, and brakes

Passenger Vehicle Implements the: v
* Body, suspension, and wheels

* Engine

» Steering, transmission, driveline, and brakes

Visualization Provides the vehicle trajectory, driver response, and 3D v
visualization

To override the default variant, on the Modeling tab, in the Design section, click the drop-down. In
the General section, select Variant Manager. In the Variant Manager, navigate to the variant that
you want to use. Right-click and select Override using this Choice.
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Slowly Increasing Steer Block

Use the Slowly Increasing Steering block to generate steering, accelerator, and brake commands for
a slowly increasing steering maneuver!!!,

* Longitudinal speed setpoint — Target velocity setpoint

* Handwheel rate — Linear rate to increase steering wheel angle

¢ Maximum handwheel angle — Maximum steering wheel angle

Longitudinal Driver
To track the vehicle speed, the Longitudinal Driver block implements an optimal single-point preview
(look ahead) control model developed by C. C. MacAdam? % %, The model represents driver steering

control behavior during path-following and obstacle avoidance maneuvers. Drivers preview (look
ahead) to follow a predefined path.

Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description

Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment

Constant (default) [Implements a constant friction value

Controllers

The Controllers subsystem generates engine torque, transmission gear, and brake commands. The
reference application has these brake variants.

Controller Variant Description

Brake Pressure Control Bang Bang ABS Anti-lock braking system (ABS) feedback
controller that switches between two states

Open Loop Open loop braking controller
(default)

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.
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Body, Suspension, Variant Description

Wheels Subsystem

PassVeh7DOF PassVeh7DOF Vehicle with four wheels:
(default)

* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw

* Each wheel has one DOF — Rolling

PassVeh14DOF PassVeh14DOF Vehicle with four wheels.

* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll

¢ Each wheel has two DOFs — Vertical and

rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine
(default)
Steering, Transmission, |Variant Description
Driveline, and Brakes
Subsystem
Driveline |Driveline All Wheel Drive |Configure the driveline for all-wheel, front-wheel,
Ideal Fixed |[model Front Wheel or rear-wheel drive
Gear Drive
Specify the type of torque coupling
Rear Wheel Drive
(default)
Transmission |Ideal (default) Ideal fixed gear transmission
Visualization

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.
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Element Description

Driver Commands

Driver commands:

* Handwheel angle
¢ Acceleration command
¢ Brake command

Vehicle Response

Vehicle response:

* Engine speed
* Vehicle speed
* Acceleration command

Yaw Rate and Steer Scope

Yaw rate and steering angle versus time:

block
* Yellow line — Yaw rate
* Blue lines — Steering angle
Steer vs Ay Scope block |Steering angle versus lateral acceleration
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Element Description
Steer, Velocity, Lat Accel |¢ SteerAngle — Steering angle versus time
Scope block + <xdot> — Longitudinal vehicle velocity versus time

* <ay> — Lateral acceleration versus time
Vehicle XY Plotter Plot of vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block |Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

3D Visualization

Optionally, you can enable or disable the 3D visualization environment. For the 3D visualization
engine platform requirements and hardware recommendations, see “3D Visualization Engine
Requirements” on page 1-5. After you open the reference application, in the Visualization subsystem,
open the 3D Engine block. Set these parameters.

* 3D Engine to Enabled.

* Scene to one of the scenes, for example Straight road.
3D Engine
(O Enabled
(@ Disabled

Engine { curved road
Parking lot
Double lane change
Open surface

Initial

» To position the vehicle in the scene:

1  Select the position initialization method:

* Recommended for scene — Set the initial vehicle position to values recommended for
the scene

* User-specified — Set your own initial vehicle position

2 Select Apply to modify the initial vehicle position parameters.

3 Click Update the model workspaces with the initial values to overwrite the initial vehicle
position in the model workspaces with the applied values.

When you run the simulation, view the vehicle response in the AutoVrt1lEnv window.

Note

* To open and close the AutoVrt1lEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrtlEnv window, Simulink stops the simulation with an error.
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*  When you enable the 3D visualization environment, you cannot step the simulation back.

To change the camera views, use these key commands.

Key Camera View
Back left
2 Back

Back
right

Left
Internal
Right
Front left
Front

w

O[O0 || 0| &

Front
right

0 Overhead
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See Also
3D Engine | Longitudinal Driver | Mapped SI Engine | Vehicle Terrain Sensor

Related Examples
. “Vehicle Steering Gain at Different Speeds” on page 1-30
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More About

“3D Visualization Engine Requirements” on page 1-5
“Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
“ISO 15037-1:2006 Standard Measurement Signals” on page 5-2
“Passenger Vehicle Dynamics Models” on page 3-2

Simulation Data Inspector



Constant Radius Maneuver

Constant Radius Maneuver

This reference application represents a full vehicle dynamics model undergoing a constant radius test
maneuver. For information about similar maneuvers, see standards SAE J266 1996011 and ISO
4138:20121. You can create your own versions, establishing a framework to test that your vehicle
meets the design requirements under normal and extreme driving conditions. Use this reference
application in ride and handling studies and chassis controls development to characterize the
steering and lateral vehicle dynamics.

You can configure the reference application for open-loop and closed-loop tests:

* Open-loop — Maintain the target velocity and steering wheel angle to determine the lateral
acceleration, side-slip characteristics, and steering angles for specific accelerations and
subsequent test maneuvers. For the open-loop test, set the Reference Generator block Maneuver
parameter to Increasing Steer.

* Closed-loop — Use the predictive driver to maintain a prespecified turn radius at different
velocities for drivability and handling performance studies. For the closed-loop test, set the
Reference Generator block Maneuver parameter to Constant radius.

To create and open a working copy of the constant radius reference application, enter

vdynblksConstRadiusStart

This table summarizes the blocks and subsystems in the reference application. Some subsystems
contain variants.

Reference Application [Description Variants
Element

Reference Generator Sets the parameters that configure the maneuver and 3D v
block visualization environment. By default, the block is set for the

constant radius maneuver with the 3D simulation engine
environment disabled.

For the minimum 3D visualization environment hardware
requirements, see “3D Visualization Engine Requirements” on
page 1-5.

To enable 3D visualization, on the 3D Engine tab, select
Enabled.

Driver Commands block |Implements the driver model that the reference application v
uses to generate acceleration, braking, gear, and steering
commands.

By default, Driver Commands block variant is the Predictive
Driver block.

\

Environment Implements wind and road forces.

Controllers Implements controllers for engine control units (ECUs), v
transmissions, and brakes
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Reference Application [Description Variants
Element
Passenger Vehicle Implements the: v

* Body, suspension, and wheels
* Engine
» Steering, transmission, driveline, and brakes

Visualization Provides the vehicle trajectory and driver response v

Reference Generator

The Reference Generator block sets the parameters that configure the maneuver and 3D simulation
environment. By default, the block is set for the constant radius maneuver with the 3D simulation
engine environment disabled.

Use the Maneuver parameter to specify the type of maneuver. You can specify the double lane
change, swept sine, sine with dwell, and slowly increasing maneuvers.

If you select the Use maneuver-specific driver, initial position, and scene parameter, the
reference application sets the driver, initial position, and scene for the maneuver that you specified.

For more information, see Reference Generator.

Driver Commands

The Driver Commands block implements the driver model that the reference application uses to
generate acceleration, braking, gear, and steering commands. By default, if you select the Reference
Generator block parameter Use maneuver-specific driver, initial position, and scene, the
reference application selects the driver for the maneuver that you specified.

Vehicle Command Implementation
Mode Setting

Longitudinal Driver |Longitudinal Driver block — Longitudinal speed-tracking controller. Based
on reference and feedback velocities, the block generates normalized
acceleration and braking commands that can vary from 0 through 1. Use
the block to model the dynamic response of a driver or to generate the
commands necessary to track a longitudinal drive cycle.

Predictive Driver |Predictive Driver block — Controller that generates normalized steering,
acceleration, and braking commands to track longitudinal velocity and a
lateral reference displacement. The normalized commands can vary
between -1 to 1. The controller uses a single-track (bicycle) model for
optimal single-point preview control.

Open Loop Implements an open-loop system so that you can configure the reference
application for constant or signal-based steering, acceleration, braking,

and gear command input.




Constant Radius Maneuver

Environment

The Environment subsystem generates the wind and ground forces. The reference application has
these environment variants.

Environment Variant Description

Ground Feedback 3D Engine Uses Vehicle Terrain Sensor block to implement
ray tracing in 3D environment

Constant (default) |[Implements a constant friction value

Controllers

The Controllers subsystem generates engine torque, transmission gear, and brake commands. The
reference application has these brake variants.

Controller Variant Description

Brake Pressure Control Bang Bang ABS Anti-lock braking system (ABS) feedback
controller that switches between two states

Open Loop Open loop braking controller
(default)

Passenger Vehicle

The Passenger Vehicle subsystem has an engine, controllers, and a vehicle body with four wheels.
Specifically, the vehicle contains these subsystems.

Body, Suspension, Variant Description

Wheels Subsystem

PassVeh7DOF PassVeh7DOF Vehicle with four wheels:
(default)

* Vehicle body has three degrees-of-freedom
(DOFs) — Longitudinal, lateral, and yaw

* Each wheel has one DOF — Rolling
PassVeh14DOF PassVeh14DOF Vehicle with four wheels.

* Vehicle body has six DOFs — Longitudinal,
lateral, vertical and pitch, yaw, and roll

¢ Each wheel has two DOFs — Vertical and

rolling
Engine Subsystem Variant Description
Mapped Engine SiMappedEngine Mapped spark-ignition (SI) engine

(default)
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Steering, Transmission, |Variant Description
Driveline, and Brakes
Subsystem
Driveline |Driveline All Wheel Drive |[Configure the driveline for all-wheel, front-wheel,
Ideal Fixed |[model EronTnnaal or rear-wheel drive
Gear Drive
Specify the type of torque coupling
Rear Wheel Drive
(default)
Transmission |Ideal (default) Ideal fixed gear transmission

Visualization

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including steering,
vehicle and engine speed, and lateral acceleration. You can use the Simulation Data Inspector to
import the logged signals and examine the data.

Wiz
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Element Description
Driver Commands Driver commands:

* Handwheel angle
e Acceleration command
¢ Brake command

Vehicle Response Vehicle response:

* Engine speed
* Vehicle speed
e Acceleration command

Steer, Velocity, Lat Accel |+ SteerAngle — Steering angle versus time
Scope block + <xdot> — Longitudinal vehicle velocity versus time
* <ay> — Lateral acceleration versus time

Vehicle XY Plotter Vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block |Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal and
lateral velocity, and sideslip angle

References

[11]J266 199601. Steady-State Directional Control Test Procedures for Passenger Cars and Light
Trucks. Warrendale, PA: SAE International, 1996.

[2]1 ISO 4138:2012. Passenger cars — Steady-state circular driving behaviour — Open-loop test
methods. Geneva: ISO, 2012.

See Also
3D Engine | Driver Commands | Reference Generator

Related Examples
. “Vehicle Lateral Acceleration at Different Speeds” on page 1-40

More About
. “3D Visualization Engine Requirements” on page 1-5
. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2

. “ISO 15037-1:2006 Standard Measurement Signals” on page 5-2
. Simulation Data Inspector
. “Slowly Increasing Steering Maneuver” on page 3-22
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Run a Vehicle Dynamics Maneuver in 3D Environment
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This example shows how to run a vehicle dynamics maneuver in a 3D environment. By integrating
vehicle dynamics models with a 3D environment, you can test advanced driver assistance systems
(ADAS) and automated driving (AD) perception, planning, and control software. For the 3D
visualization engine platform requirements and hardware recommendations, see “3D Visualization
Engine Requirements” on page 1-5.

1 Create and open a working copy of a maneuver reference application. For example, open the
double-lane change reference application.

vdynblksDblLaneChangeStart
2  Run the maneuver simulation. By default, the 3D environment is disabled.

When you run the simulation, the Visualization subsystem provides driver, vehicle, and response
information. The reference application logs vehicle signals during the maneuver, including
steering, vehicle and engine speed, and lateral acceleration. You can use the Simulation Data
Inspector to import the logged signals and examine the data.


matlab:vdynblksDblLaneChangeStart

Run a Vehicle Dynamics Maneuver in 3D Environment

Critrl

-

Lane
Lane Changa
—
p————————————
<Braka> 5
l SteerAngle T
H
L]
- l—b' Unit:
<EngSpd= | | R gine_rpm —
(G r—1¢4+—» | = | uniemen StesrAngle
<ydat> nme ot_mph — dot> »
WehFdbk A0
gy ul
Stear, Velocity, Lat Accal
| VahFdibk
VehFdbk
Vehicle XY Plotter
'
3D Engine
Dizabled
| VehFdbk
IS0 15037-1:2006
| it
IS0 15037-1:2006
Disabled
Element Description

Driver Commands

Driver commands:

* Handwheel angle
¢ Acceleration command
e Brake command

Vehicle Response

Vehicle response:

* Engine speed
* Vehicle speed
¢ Acceleration command
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3

Element Description
Lane Change Scope Lateral vehicle displacement versus time:
block

* Red line — Cones marking lane boundary
* Blue line — Reference trajectory
* Green line — Actual trajectory

Steer vs Ay Scope block |Steering angle versus lateral acceleration

Steer, Velocity, Lat * SteerAngle — Steering angle versus time

Accel Scope block ¢ <xdot> — Longitudinal vehicle velocity versus time

* <ay> — Lateral acceleration versus time

Vehicle XY Plotter Vehicle longitudinal versus lateral distance

ISO 15037-1:2006 block | Display ISO standard measurement signals in the Simulation Data
Inspector, including steering wheel angle and torque, longitudinal
and lateral velocity, and sideslip angle

Enable the 3D visualization environment. In the Visualization subsystem, open the 3D Engine
block. Set these parameters.

* 3D Engine to Enabled.
* Scene description to one of the scenes, for example Double lane change.

3D Engine
(® Enabled
) Disabled

Scene: |Double lane change

) Straight road
Engine | Curved road

Initial  Parking lot
Double lane change A
_ | Open surface

* To position the vehicle in the scene:

a  Select the position initialization method:
* Recommended for scene — Set the initial vehicle position to values recommended
for the scene
+ User-specified — Set your own initial vehicle position
b  Select Apply to modify the initial vehicle position parameters.

¢ Click Update the model workspaces with the initial values to overwrite the initial
vehicle position in the model workspaces with the applied values.

Rerun the reference application. As the simulation runs, in the AutoVrt1lEnv window, view the
vehicle response.

To change the camera views, use these key commands.



Run a Vehicle Dynamics Maneuver in 3D Environment
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For example, when you run the double-lane change maneuver, use the cameras to visualize the
vehicle as it changes lanes.

e Back
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e Front left
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e Internal
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Note

* To open and close the AutoVrtlEnv window, use the Simulink Run and Stop buttons. If you
manually close the AutoVrt1lEnv window, Simulink stops the simulation with an error.

*  When you enable the 3D visualization environment, you cannot step the simulation back.

See Also

More About

. “Double-Lane Change Maneuver” on page 3-4

. “Slowly Increasing Steering Maneuver” on page 3-22

. “Swept-Sine Steering Maneuver” on page 3-15

. Simulation Data Inspector

. “Support Package for Customizing Scenes” on page 6-3
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Kinematics and Compliance Virtual Test Laboratory

Model-Based Calibration Toolbox allows you to generate optimized suspension parameters for the
Independent Suspension - Mapped and Solid Axle Suspension - Mapped blocks by using the
kinematics (K) and compliance (C) virtual test laboratory.

To create and open a working copy of the K and C virtual test laboratory reference application, enter
vdynblksKandCTestLabStart

The K and C virtual test laboratory contains vehicle, test system, and test control subsystems. The
vehicle system has two variants:

* Simscape Multibody Vehicle — Vehicle with a Simscape Multibody suspension system
* VDBS Vehicle — Vehicle with an Independent Suspension - Mapped block

DoE Chirp Test
* \eh
LabCtrl
» Lab
i » Veh
Test Control
# LabCtr Weh —
» LabCtrl Lab —
# Lab ‘u’ehF‘hysE[ VehPhys
Test System
Vehicle

This table summarizes the virtual test laboratory tests.
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Test

Objective

Method

Generate Mapped
Suspension from
Spreadsheet Data

Use measured vertical
force and suspension
geometry data to
generate calibrated
suspension parameters
for the mapped
suspension blocks.

Note You can use a
third-party simulation
model to generate the
measured suspension
data.

The virtual test lab uses Model-Based Calibration
Toolbox to fit camber angle, toe angle, and vertical
force response models for the data. The virtual
test lab then uses the response models to generate
suspension parameters for the suspension blocks.

Generate Mapped
Suspension from
Simscape Suspension

Use a Simscape
Multibody suspension
system to generate
calibrated suspension
parameters for the
suspension mapped
blocks.

The virtual test lab uses Model-Based Calibration
Toolbox to perform a Sobol sequence design of
experiments (DoE) on the suspension height and
handwheel angle operating points. At each
operating point, the reference application
stimulates the Simscape Multibody suspension
system with a chirp signal over a frequency range
of 0.1 to 2 Hz. The virtual test lab then uses the
data to fit the suspension vertical force, camber
angle, and toe angle with a Gaussian process
model (GPM) as a function of the suspension state.
Finally, the reference application uses the GPM to
generate suspension parameters for the
suspension blocks.

Compare Mapped and
Simscape Suspension
Responses

Compare the mapped
suspension with the
Simscape Multibody
suspension results.

The virtual test laboratory stimulates the
Simscape Multibody suspension at one operating
point and then compares the response to the
mapped suspension.

Generate Mapped Suspension from Spreadsheet Data

The virtual test lab uses Model-Based Calibration Toolbox to fit camber angle, toe angle, and vertical
force response models for the data. The virtual test lab then uses the response models to generate

suspension parameters for the suspension blocks.

Generate Mapped Suspension Calibration

1 Use the Spreadsheet file field to provide a data file. By default, the reference application has
KandCTestData.xlsx containing required data. The table summarizes the data file

requirements for generating calibrated tables.
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Data Description Data Requirements for
Generating Mapped
Suspension Tables

z Vertical axis suspension height, in |Required
m

zdot Vertical axis suspension height Required
velocity breakpoints, in m/s

str Steering angle, in rad Required

Fz Vertical axis suspension force, in |Required
N

ca Camber angle, in rad Required

ta Toe angle, in rad Required

2 Click Generate mapped suspension calibration to generate response surface models in
Model-Based Calibration Toolbox.

The model browser opens when the process completes. You can view the camber angle, caq, toe
angle, ta, and vertical force, Fz, response model fits for the data.

File Model  View Outliers  Window  Help

@ LOcd & kXxE 7 o db ‘23| @[] [ [ ] &

All Models /@ Response Model: ca
@ MappedSuspensionil
- E MappedSuspensic

Model type: Gaussian Process Model (ARDSquaredExponential, Constant)

@ i3 Response Surface fm X
- MappedSuspensic Plot: Surface >
@ Fz X-axis: |str w
Y-axiz. |z w
Name: Walue Tolerance
sir -0.382604f || Linked to X-... E
z -0.027561¢L_|[Linked to ¥'-... H

Select Data Point... str [rad]

Apply Calibration to Mapped Suspension Model

1 Click Apply calibration to mapped suspension model. The virtual test lab uses the response
models to generate calibrated suspension and breakpoint data.

2 Click OK to update the model workspace and suspension blocks.

In the Model Explorer, you can view the generated suspension parameters.
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Model Hierarchy

2 =

v P21 simulink Root
E Base Workspace

v [*a] KandcvirtuarTestLab
E Model Workspace*

'@,‘; Configurations

Subsystem4

E Contents of; Model Workspace* (only)

Veh_PARAM
% f_susp_axl_bp

Column View: |Data Objects * | Show Details
Mame Value
% DOEMAT [0.0500.05 0.1 2 100]

<1x1 struct>

Test Control [12]

Test System % f_susp_dz_bp [-0.0275619067514496 -0.02067

Vehicle % f_susp_dzdot_bp [-0.720046014836431 -0.54003<
% f_susp_fmz <5D double=
% f_susp_geom <4-D double=
% f_susp_strgdelta_bp [-0.382604972274104 -0.369851
[s] vtol 0.1

Parameter Model Workspace Description

Variable

Axle breakpoints,
f susp_axl bp

f susp axl bp

Axle breakpoints, P, dimensionless.

Vertical axis
suspension height
breakpoints,
f susp _dz_bp

f susp dz bp

Vertical axis suspension height breakpoints, M,
in m.

Vertical axis
suspension height
velocity breakpoints,
f susp_dzdot_bp

f susp dzdot bp

Vertical axis suspension height velocity
breakpoints, N, in m/s.

Vertical axis
suspension force and
moment responses,

f susp fmz

f susp fmz

M-by-N-by-0-by-P-by-4 array of output values as
a function of:

* Vertical suspension height, M

» Vertical suspension height velocity, N

* Steering angle, O

e Axle, P

* 4 output types

e 1 — Vertical force, in N'm
e 2 — User-defined

* 3 — Stored energy, in ]

* 4 — Absorbed power, in W
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Parameter

Model Workspace
Variable

Description

Suspension geometry
responses,
f susp_geom

f susp _geom

M-by-0-by-P-by-3 array of geometric suspension
values as a function of:

* Vertical suspension height, M

* Steering angle, O

* Axle, P

* 3 output types

e 1 — Camber angle, in rad
* 2 — Caster angle, in rad
* 3 — Toe angle, in rad

Steering angle
breakpoints,
f susp_strgdelta_bp

f susp strgdelta bp

Steering angle breakpoints, O, in rad.

Generate Mapped Suspension from Simscape Suspension

The virtual test lab uses Model-Based Calibration Toolbox to perform a Sobol sequence design of
experiments (DoE) on the suspension height and handwheel angle operating points. At each
operating point, the reference application stimulates the Simscape Multibody suspension system with
a chirp signal over a frequency range of 0.1 to 2 Hz. The virtual test lab then uses the data to fit the
suspension vertical force, camber angle, and toe angle with a Gaussian process model (GPM) as a
function of the suspension state. Finally, the reference application uses the GPM to generate
suspension parameters for the suspension blocks.

The test laboratory exercises the suspension system with the DOE settings contained in the DOEMAT
array. To view the DOEMAT array values, open the Model Explorer.

Element

Description

DOEMAT(1,1)

Suspension height

DOEMAT(1,2)

Handwheel angle

DOEMAT(1,3)

Chirp signal amplitude

DOEMAT(1,4)

Starting chirp frequency

DOEMAT(1,5)

Ending chirp frequency

DOEMAT(1,6)

Simulation time to complete chirp signal frequency range

The generation can take time to run and slow other computer processes. View progress in the

MATLAB window.

In the Model Explorer, you can view the generated suspension parameters.
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Model Hierarchy

2 =

v P21 simulink Root
E Base Workspace

v [*a] KandcvirtuarTestLab
E Model Workspace*

'@,‘; Configurations

Subsystem4

E Contents of; Model Workspace* (only)

Veh_PARAM
% f_susp_axl_bp

Column View: |Data Objects * | Show Details
Mame Value
% DOEMAT [0.0500.05 0.1 2 100]

<1x1 struct>

Test Control [12]

Test System % f_susp_dz_bp [-0.0275619067514496 -0.02067

Vehicle % f_susp_dzdot_bp [-0.720046014836431 -0.54003<
% f_susp_fmz <5D double=
% f_susp_geom <4-D double=
% f_susp_strgdelta_bp [-0.382604972274104 -0.369851
[s] vtol 0.1

Parameter Model Workspace Description

Variable

Axle breakpoints,
f susp_axl bp

f susp axl bp

Axle breakpoints, P, dimensionless.

Vertical axis
suspension height
breakpoints,
f susp _dz_bp

f susp dz bp

Vertical axis suspension height breakpoints, M,
in m.

Vertical axis
suspension height
velocity breakpoints,
f susp_dzdot_bp

f susp dzdot bp

Vertical axis suspension height velocity
breakpoints, N, in m/s.

Vertical axis
suspension force and
moment responses,

f susp fmz

f susp fmz

M-by-N-by-0-by-P-by-4 array of output values as
a function of:

* Vertical suspension height, M

» Vertical suspension height velocity, N

* Steering angle, O

e Axle, P

* 4 output types

e 1 — Vertical force, in N'm
e 2 — User-defined

* 3 — Stored energy, in ]

* 4 — Absorbed power, in W
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Parameter

Model Workspace
Variable

Description

Suspension geometry
responses,
f susp_geom

f susp _geom

M-by-0-by-P-by-3 array of geometric suspension
values as a function of:

* Vertical suspension height, M

* Steering angle, O

* Axle, P

* 3 output types

e 1 — Camber angle, in rad
* 2 — Caster angle, in rad
* 3 — Toe angle, in rad

Steering angle
breakpoints,
f susp_strgdelta_bp

f susp strgdelta bp

Steering angle breakpoints, O, in rad.

Compare Mapped and Simscape Suspension Responses

The virtual test laboratory stimulates the Simscape Multibody suspension at one operating point and
then compares the response to the mapped suspension.

» To stimulate the Simscape Multibody suspension model, the test laboratory uses with the DOE
settings contained in the DOEMAT array.

During the simulation, to view the suspension system, select the Mechanics Explorers tab.
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MECHANICS EXPLORERS VIEW

MATLAE » Projects » slexamples » KandCVirtualTestLab »
Simulink Project - KandCVirtualTestLab | Mechanics Explorers - Mechanics Explorer-Kand CVirtualTestLabAg
| Mechanics Explorer-KandCVirtualTestLabActuater 0 |

2, r:andcwrtuawestLab.qctuat4f
---DDD Actuator_LF
---':'D':' Actuator_LR
---Dg':' Actuator_RF
---DDD Actuator_ RR
- Body

- Steering
---Dg':' Susp_LF
---DDD Susp_LR v
---DD':' Susp_RF L
---':'D':' Susp_RR :
---Dg':' World_Clamp
-4 Prismatic_Rack
-4 Spherical_Spindle_TiL f :
- i@ Spherical_Spindle_TiR

F-Connection Frames
£

~
.

L.

» After the simulation completes, use the Simulation Data Inspector to compare the suspension
system response for the mapped suspension and Simscape Multibody suspension model. For
example, compare the vertical force, camber angle, and toe angle responses.
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See Also
Independent Suspension - Mapped | Solid Axle Suspension - Mapped

More About

. Simulation Data Inspector
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Send and Receive Double-Lane Change Scene Data
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This example shows you how to use the Simulation 3D Message Set and Simulation 3D Message Get
blocks to communicate with the 3D visualization environment when you run the double-lane change
maneuver. Specifically, you use the:

* Simulation 3D Message Get block to retrieve how many cones the vehicle hits during the
maneuver.
« Simulation 3D Message Set block to control the traffic signal light.

For the minimum hardware required to run the example, see the “3D Visualization Engine
Requirements” on page 1-5.

Run a Double-Lane Change Maneuver That Hits Cones

With the 3D visualization environment enabled, run a double-lane change maneuver that hits the
cones.

1 Create and open a working copy of the double-lane change reference application project.

vdynblksDblLaneChangeStart

2 Enable the 3D visualization environment. In the Visualization subsystem, open the 3D Engine
block mask and select Enabled. Apply the changes and save the model.

Alternatively, at the MATLAB command prompt, enter this code.
See Code That Enables 3D Environment

% Enable the 3D visualization environment

mdl = 'DLCReferenceApplication’;

set param([mdl '/Visualization/3D Engine'], 'engine3D', 'Enabled');
save_system(mdl)

3 In the top level of the model, set the Lane Change Reference Generator block parameters so that
the vehicle does not successfully complete the maneuver. Set these block parameters, apply the
changes, and save the model.

* Maneuver start time to 5.

* Longitudinal entrance velocity setpoint to 40.
Alternatively, at the MATLAB command prompt, enter this code.
See Code That Sets Parameters

% Set Lane Change Reference Generator block parameters

mdl = 'DLCReferenceApplication’;

set param([mdl '/Lane Change Reference Generator'],'t start','5');
set param([mdl '/Lane Change Reference Generator'], 'xdot r','40');
save_system(mdl)

4 Run the maneuver. As the simulation runs, in the AutoVrtlEnv window, you can see the vehicle
hitting the cones.


matlab:vdynblksDblLaneChangeStart

Send and Receive Double-Lane Change Scene Data

Use Simulation 3D Message Get Block to Retrieve Cone Data

Use the Simulation 3D Message Get block to retrieve how many cones the vehicle hits during the
maneuver. By default, the maneuver uses the double-lane change scene.

1

Navigate to the Visualization > 3D Engine subsystem. Right-click the 3D Engine block and select
Mask > Look Under Mask. In the Visualization > 3D Engine > 3D Engine subsystem, insert
these blocks:

* Simulation 3D Message Get

» Display

* Math Function

Set the Simulation 3D Message Get block parameters so that the block retrieves cone data from
the double-lane change scene. Set these block parameters, apply the changes, and save the
model.

* Signal name, SigName to NumOfConesHit

* Data type, DataType to boolean

* Message size, MsgSize to [2 15]

* Sample time to -1
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Block Parameters: Simulation 3D Message Get X
Simulation 3D Message Get (mask) (link)

Retrieves data from the 3D visualization environment. To use the
block, install the support package for customizing scenes. If you set
the sample time to -1, the block uses the sample time specified in the
Simulation 3D Scene Configuration block. Ensure that the Simulation
3D Scene Configuration block is in your model.

Parameters

Signal name, SigName []: |Num0ﬂ;‘onesHit |

Data type, DataType []: |boolean -

Message size, MsgSize []: |[2 15] | g

Sample time: |—1 | g

Alternatively, at the MATLAB command prompt, enter this code.

See Code That Sets Parameters

% Set these Simulation 3D Message Get block parameters
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';

set param([visualss '/Simulation 3D Message Get'],'SigName', 'NumOfConesHit"');
set param([visualss '/Simulation 3D Message Get'], 'DataType', 'boolean');

set param([visualss '/Simulation 3D Message Get'], 'MsgSize','[2 15]");

set param([visualss '/Simulation 3D Message Get'],'Ts','-1');

save system(mdl)

3  Set the Math Function block Output dimensionality parameter to transpose. When you run
the simulation, the Math Function block outputs a [15 2] array.

Block Parameters: Math Function x
Math

Mathematical functions including logarithmic, exponential, power, and
modulus functions. When the function has more than one argument, the
first argument corresponds to the top (or left) input port.

Main  Signal Attributes
Function: | transpose A

Output signal type: |auto -

Alternatively, at the MATLAB command prompt, enter this code.

See Code That Sets Parameters

% Set the Math Function block parameter to transpose the array
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';
set param([visualss '/Math Function'], 'Function', 'transpose');
save system(mdl)

4 Connect the Simulation 3D Message Get, Math Function, and Display blocks as shown. Confirm
the block parameters. Save the model.
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05 4
wap- | 2 2 3| Readusg e ul h:l
E B 1
Math Dizplay
Function

Simulation 3D Meszage Get

'

Simulation 3D Scene Configuration

Verify that the Simulation 3D Scene Configuration block executes before the Simulation 3D
Message Get block. That way, the Unreal Engine 3D visualization environment prepares the data
before the Simulation 3D Message Get block receives it. To check the block execution order,
right-click the blocks and select Properties. On the General tab, confirm these Priority
settings:

* Simulation 3D Scene Configuration — 0

* Simulation 3D Message Get — 1

For more information about execution order, see “Control and Display Execution Order”
(Simulink).

Run the maneuver. As the simulation runs, the display block updates with the ReadMsg boolean
value 1 when the vehicle hits the corresponding cone.
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Display

The results indicate that the vehicle hits SM_Cone20, SM_Cone29, and SM_Cone30 during the
maneuver.

This table provides the Double Lane Change scene cone name that corresponds to the ReadMsg
array element.

Simulation 3D

Unreal® Editor Cone

Simulation 3D

Unreal Editor Cone

Message Get Block [Name Message Get Block |[Name
ReadMsg Value Array Element

ReadMsg(1,1) SM _Cone5 ReadMsg(2,1) SM Conel0
ReadMsg(1,2) SM Cone4 ReadMsg(2,2) SM_Cone09
ReadMsg(1,3) SM Cone3 ReadMsg(2,3) SM Cone08
ReadMsg(1,4) SM Cone2 ReadMsg(2,4) SM Cone07
ReadMsg(1,5) SM Cone01 ReadMsg(2,5) SM Cone06
ReadMsg(1,6) SM Conel5 ReadMsg(2,6) SM Cone20
ReadMsg(1,7) SM Conel4d ReadMsg(2,7) SM Conel9
ReadMsg(1,8) SM Conel3 ReadMsg(2,8) SM Conel8
ReadMsg(1,9) SM Conel2 ReadMsg(2,9) SM Conel7
ReadMsg(1,10) SM Conell ReadMsg(2,10) SM Conel6
ReadMsg(1,11) SM Cone25 ReadMsg(2,11) SM Cone30
ReadMsg(1,12) SM Cone24 ReadMsg(2,12) SM Cone29
ReadMsg(1,13) SM Cone23 ReadMsg(2,13) SM Cone28
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Simulation 3D Unreal® Editor Cone |Simulation 3D Unreal Editor Cone
Message Get Block |Name Message Get Block |Name

ReadMsg Value Array Element

ReadMsg(1,14) SM Cone22 ReadMsg(2,14) SM Cone27
ReadMsg(1,15) SM Cone21 ReadMsg(2,15) SM Cone26

Use Simulation 3D Message Set Block to Control Traffic Signal Light

1

Navigate to the Visualization > 3D Engine subsystem. Right-click the 3D Engine block and select
Mask > Look Under Mask. In the Visualization > 3D Engine > 3D Engine subsystem, insert
these blocks:

* Simulation 3D Message Set

* Data Type Conversion

* Stair Generator

Set the Simulation 3D Message Set block parameters so that the block sends traffic signal data to
the double-lane change scene. Set these block parameters, apply the changes, and save the
model.

* Signal name, SigName to TrafficLightl

* Sample time to -1

Block Parameters: Simulation 3D Message Set *
Simulation 3D Message Set (mask) (link)

Sends data to the 3D visualization environment. To use the block,
install the support package for customizing scenes. If you set the
sample time to -1, the block uses the sample time specified in the
Simulation 3D Scene Configuration block. Ensure that the Simulation
3D Scene Configuration block is in your model.

Parameters

Signal name, SigName []: |Trafﬁcljght1 |

Sample time: |—1 | g

This table provides the scene traffic signal light color that corresponds to the WriteMsg value in
the Double Lane Change scene.

Simulation 3D Message Set Block TrafficlLightl Color
WriteMsg Value

0 Red

1 Yellow

2 Green

Alternatively, at the MATLAB command prompt, enter this code.

See Code That Sets Parameters

% Set Simulation 3D Message Set block parameters
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';
set param([visualss '/Simulation 3D Message Set'],'SigName', 'TrafficLightl');
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set param([visualss '/Simulation 3D Message Set'],'Ts','-1");
save system(mdl)

Set the Data Type Conversion block parameters to convert data to int32. Set these block
parameters, apply the changes, and save the model.

*  Output data type to int32

Alternatively, at the MATLAB command prompt, enter this code.

See Code That Sets Parameters

% Set Data Type Conversion block parameters
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';
set param([visualss '/Data Type Conversion'],'OutDataTypeStr','int32');
save system(mdl)

Set the Stair Generator block parameters to send a command that corresponds to red, yellow,
and green traffic light signals. Set these block parameters, apply the changes, and save the
model.

* Timeto [0,2,3,5,8]

* Amplitude to [0,0,1,2,2]

* Sample time to 1

Block Parameters: Stair Generator X
Stair Generator (mask) (link)

Generate a signal changing at specified times. Output is kept at 0
until the first specified transition time.

Parameters
Time (s):
[0,2,3,5,8] IE

Amplitude:
[0,0,1,2,2] IE

Sample time

£ [E

Alternatively, at the MATLAB command prompt, enter this code. Apply the block changes and
save the model.

See Code That Sets Parameters

% Set Stair Generator block parameters
visualss='DLCReferenceApplication/Visualization/3D Engine/3D Engine';
open_system([visualss '/Stair Generator']);
set param([visualss '/Stair Generator'],'e’,
set param([visualss '/Stair Generator'],'t',
set param([visualss '/Stair Generator'],'Ts','

Connect the blocks as shown. Confirm the block parameters and signal connections. Save the
model.

'10,0,1,2,2]");
'10,2,3,5,81");
1');
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Simulation 30 Message Set

Verify that the Simulation 3D Message Set block executes before the Simulation 3D Scene
Configuration block. That way, Simulation 3D Message Set prepares the signal data before the
Unreal Engine 3D visualization environment receives it. To check the block execution order,
right-click the blocks and select Properties. On the General tab, confirm these Priority
settings:

* Simulation 3D Scene Configuration — 0
* Simulation 3D Message Set — -1

For more information about execution order, see “Control and Display Execution Order”
(Simulink).

Run the maneuver. As the simulation runs, in the AutoVrtlEnv window, you can see the
TrafficLightl light change from red to yellow to green.
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Time Range (s) WriteMsg Value TrafficLightl Color
0-3 0 Red
3-5 1 Yellow
5-8 2 Green
See Also

3D Engine | Double Lane Change | Simulation 3D Message Get | Simulation 3D Message Set |

Simulation 3D Scene Configuration

Related Examples

. “Double Lane Change Reference Application” on page 7-4
. “Yaw Stability on Varying Road Surfaces” on page 1-18

More About

. “Support Package for Customizing Scenes” on page 6-3
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“3D Visualization Engine Requirements” on page 1-5
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4 Project Templates

Vehicle Dynamics Blockset Project Templates

Vehicle Dynamics Blockset provides preassembled vehicle dynamics models that you can use to
analyze the dynamic system response to common ride and handling tests. Use the templates to create
vehicle dynamic model variants for the maneuver reference applications. Open project files that
contain the vehicle models from the Simulink start page.

1 In Simulink, on the Simulation tab, select New > Project > New Project.

In the Simulink start page, browse to Vehicle Dynamics Blockset and select Passenger 3DOF
Vehicle, Passenger 7DOF Vehicle, or Passenger 14DOF Vehicle.

In the Create Project dialog box, in Project name, enter a project name.

In Folder, enter a project folder or browse to the folder to save the project.

Click OK.

If the folder does not exist, the dialog box prompts you to create it. Click Yes.

The software compiles the project and populates the project folders. All models and supporting
files are in place for you to customize your vehicle dynamics model.

This table summarizes the vehicle dynamics project templates.

Vehicle |Description Vehicle Body Degrees-of-Freedom Wheel DOFs
Model (DOFs)
Passeng |* Vehicle with |Six Two per wheel - eight total
er four wheels
LADIOIE | el o Translational Rotational Translational [Rotational
Vehicle model Longitudinal v/ |Pitch v Vertical |v |Rolling | v
;’;rlant I llLateral v |Yaw v
e
maneuver || Vertical v |Roll 4
reference
applications
Passeng |* Vehicle with |Three One per wheel - four total
er 7DOF four wheels
Vehicle (I, Available as Translational Rotational Rotational
model Longitudinal v |Pitch Rolling v
:ﬁglant n Lateral v |Yaw v
maneuver || Vertical Roll
reference
applications
Passeng |¢ Vehicle with |Three None
er 3DOF ideal tire
Vehicle Translational Rotational
Longitudinal v |Pitch
Lateral v |Yaw v
Vertical Roll
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See Also

More About

. “Double-Lane Change Maneuver” on page 3-4
. “Slowly Increasing Steering Maneuver” on page 3-22
. “Swept-Sine Steering Maneuver” on page 3-15
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5 Maneuver Standards

ISO 15037-1:2006 Standard Measurement Signals

5-2

You can configure the maneuver reference applications to display ISO 15037-1:2006!"! standard
measurement signals in the Simulation Data Inspector, including steering wheel angle and torque,
longitudinal and lateral velocity, and sideslip angle.

To configure the ISO signal display, in the reference application Visualization subsystem, open the
ISO 15037-1:2006 block. Select Enabled. After you run the maneuver, the Simulation Data Inspector
opens with standard measurements.

For example, to display the ISO signals when you run the double lane change maneuver:
1 Create and open a working copy of the double-lane change reference application project.

vdynblksDblLaneChangeStart

2 In the Visualization subsystem, open the ISO 15037-1:2006 block. Select Enabled. Save the
reference application.

3  Run the maneuver. As the simulation runs, view the ISO standard measurement signals in the
Simulation Data Inspector, including steering wheel angle and torque, longitudinal and lateral
velocity, and sideslip angle.

W Steering-wheel angle

0 2 4 3} 8 10 12 14 16 13

W Steering-wheel torgue

0 2 4 3} 8 10 12 14 16 13

W Longitudinal velocity m Lateral velocity

[
-]

a 2 4 5] g 10 12 14 16 18

W Sideslip angle

[
-]

References

[1]1ISO 15037-1:2006. Road vehicles -- Vehicle dynamics test methods -- Part 1: General conditions for
passenger cars. ISO (International Organization for Standardization), 2014.


matlab:vdynblksDblLaneChangeStart

ISO 15037-1:2006 Standard Measurement Signals

See Also

More About

. “Double-Lane Change Maneuver” on page 3-4

. “Slowly Increasing Steering Maneuver” on page 3-22
. “Swept-Sine Steering Maneuver” on page 3-15

. Simulation Data Inspector

External Websites

. International Organization for Standardization
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Support Package For Maneuver and Drive Cycle Data

This example shows how to install additional maneuver and drive cycle data from a support package.
By default, the Drive Cycle Source block has the FTP-75 drive cycle data. The support package has
drive cycles that include the gear shift schedules, for example JC08 and CUEDC.
In the Drive Cycle Source block, click Install additional drive cycles to start the installer.
Follow the instructions and default settings provided by the installer to complete the installation.
On the Select a support package screen, select the data you want to add:

Accept or change the Installation folder and click Next.

Note You must have write permission for the Installation folder.

See Also
Drive Cycle Source
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Support Package for Customizing Scenes

Vehicle Dynamics Blockset comes installed with prebuilt 3D scenes in which to simulate and visualize
the vehicles modeled in Simulink. These 3D scenes are visualized using the Unreal Engine from Epic
Games. By using the Unreal Editor, you can customize these scenes or simulate within the scenes
from your own custom project.

With custom scenes, you can co-simulate within Simulink and the Unreal Editor so that you can
modify your scenes between simulation runs. You can also package your scenes into an executable file
and simulate without the Unreal Editor. Executable files do not require opening the Unreal Editor to
simulate your scene. Instead, the scene runs by using the Unreal Engine that comes installed with
Vehicle Dynamics Blockset.

To customize 3D scenes, you need to be familiar with creating and modifying scenes in the Unreal
Editor. To simulate with these custom scenes, in your Simulink model, you must set the Simulation 3D
Scene Configuration block parameter Scene source to Unreal Executable or Unreal Editor.

This table provides the steps for customizing the scenes.

Step Description

“Verify Software and Hardware
Requirements (One-Time Step)” on
page 6-3

Verify the software and hardware requirements.

“Install Support Package and
Configure Scene Customization (One-
Time Step)” on page 6-4

Use the Add-On Explorer to install the support package that
contains the Unreal Engine 4.23 project file.

Set up the 3D simulation environment to use the project file.

“Migrate Projects Developed Using
Prior Support Packages” on page 6-
6 (Optional)

Migrate a project that you developed using a prior release of
the Vehicle Dynamics Blockset Interface for Unreal Engine 4
Projects support package.

“Open Unreal Editor from MATLAB”
on page 6-6

Establish a connection between the Unreal Editor, MATLAB,
and Simulink so that you can edit scenes.

“Create or Modify Scenes in Unreal
Editor” on page 6-8

Use the Unreal Editor to customize the scenes in the project.

You can use the Simulation 3D Message Set and Simulation
3D Message Get blocks to send and receive scene data from
the Unreal Engine 3D visualization environment. You must
configure the visualization environment to communicate with
the Simulink model data. For information, see the block
documentation and the support package file

QuickStart Message Get Set.

“Co-Simulate Scene in Unreal Editor
and Simulink” on page 6-10

Simulate the custom scene in both the Unreal Editor and
Simulink.

“Simulate Custom Scene Using
Executable (Optional)” on page 6-11

Create an Unreal Engine project executable file that contains
your updates.

Verify Software and Hardware Requirements (One-Time Step)

Before creating custom scenes, make sure that your environment meets the minimum software and

hardware requirements.
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Software Requirements
* Windows 64-bit platform — The 3D simulation environment is not supported on Mac and Linux
platforms.

* Unreal Editor 4.23 — To customize scenes, you must have this specific version of the Unreal
Editor installed. To download this version, see the Unreal Engine website.

* Visual Studio 2017 or higher — This software is required for using the Unreal Editor to
customize scenes.

* Microsoft DirectX — If this software is not already installed on your machine and you try to
simulate in the 3D environment, Vehicle Dynamics Blockset prompts you to install it. Once you
install the software, you must restart the simulation.

* Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects Support Package — For
installation and setup instructions, see “Install Support Package and Configure Scene
Customization (One-Time Step)” on page 6-4.

Minimum Hardware Requirements

The 3D simulation environment also requires:

* Graphics card (GPU) — Virtual reality-ready GPU with 8 GB of onboard RAM
* Processor (CPU) — 2.60 GHz
* Memory (RAM) — 12 GB

Install Support Package and Configure Scene Customization (One-Time
Step)
Install Support Package

1 Onthe MATLAB Home tab, in the Environment section, select Add-Ons > Get Add-Ons.

lvf @ (+ % Community
E Reguest Support

Add-Onz Help
+  [E] Learn MATLAB

Get Add-Ons

Manage Add-Ons

Package Toolbox

@ "Il’:] 3"] 8: ‘

Package App

2 In the Add-On Explorer window, search for the Vehicle Dynamics Blockset Interface for Unreal
Engine 4 Projects support package. Click Install.

Note You must have write permission for the installation folder.
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Configure Scene Customization Using Support Package
The support package includes:

* An Unreal Engine project, AutoVrtlEnv.uproject, and its associated files. The project includes
editable versions of the prebuilt 3D scenes that you can select from the Scene description
parameter of the Simulation 3D Scene Configuration block. To use this project, you must copy the
file to a folder on your local machine.

* A plugin file, MathWorkSimulation.uplugin. This plugin establishes the connection between
MATLAB and the Unreal Editor and is required for co-simulation. You must copy this plugin to
your local installation of the editor.

To copy the project to a local folder and the plugin to your Unreal Editor installation, follow these
one-time steps. Use the Code That Configures Scene Configuration (Steps 1-4).

St |Description
ep
1 |Specify the location of the support package project files and a local folder destination.

Note You must have write permission for the local folder destination.

2 | Specify the location of the Unreal Engine installation, for example C:\Program Files\Epic
Games\UE _4.23.

3 |Copy the MathWorksSimulation plugin to the Unreal Engine plugin folder.

Copy the support package folder that contains the AutoVrtlEnv.uproject files to the local
folder destination.

Code That Configures Scene Configuration (Steps 1-4)

%% STEP1
% Specify the location of the support package project files and a local folder destination
s Note: Only one path is supported. Select latest download path.
dest root = "C:\Local";
src_root = fullfile(matlabshared.supportpkg.getSupportPackageRoot,
"toolbox", "shared", "sim3dprojects", "automotive");

o

%% STEP2
% Specify the location of the Unreal Engine installation.
ueInstFolder = "C:\Program Files\Epic Games\UE 4.23";

%% STEP3

% Copy the MathWorksSimulation plugin to the Unreal Engine plugin folder.
mwPluginName = "MathWorksSimulation";

mwPluginFolder = fullfile(src_root, "PluginResources", "UE423"); % choose UE version

uePluginFolder = fullfile(ueInstFolder, "Engine", "Plugins");
uePluginDst = fullfile(uePluginFolder, "Marketplace", "MathWorks");

cd(uePluginFolder)
foundPlugins = dir("**/" + mwPluginName + ".uplugin");

if ~isempty(foundPlugins)
numPlugins = size(foundPlugins, 1);
msg2 = cell(1l, numPlugins);
pluginCell = struct2cell(foundPlugins);

msgl = "Plugin(s) already exist here:" + newline + newline;
for n = 1l:numPlugins

msg2{n} =" " + pluginCell{2,n} + newline;
end

msg3 = newline + "Please remove plugin folder(s) and try again.";
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msg = msgl + msg2 + msg3;

warning(msg);
else

copyfile(mwPluginFolder, uePluginDst);

disp("Successfully copied MathWorksSimulation plugin to UE4 engine plugins!")
end

%% STEP4
Copy the support package folder that contains the AutoVrtlEnv.uproject
files to the local folder destination.
projFolderName = "AutoVrtlEnv";
projSrcFolder = fullfile(src _root, projFolderName);
projDstFolder = fullfile(dest root, projFolderName);
if ~exist(projDstFolder, "dir")
copyfile(projSrcFolder, projDstFolder);
end

%
%

Migrate Projects Developed Using Prior Support Packages

If your Simulink model uses an Unreal Engine executable or project developed using a prior release
of the Vehicle Dynamics Blockset Interface for Unreal Engine 4 Projects support package, you must
migrate the project to make it compatible with Unreal Editor 4.23. Follow these steps:

1 Open Unreal Engine 4.23. For example, navigate to C:\Program Files\Epic Games
\UE 4.23\Engine\Binaries\Win64 and open UE4Editor.exe.
2 Use the Unreal Project Browser to open the project that you want to migrate.

Follow the prompts to open a copy of the project. The editor creates a new project folder in the
same location as the original, appended with 4.23. Close the editor.

4 In a file explorer, remove the space in the migrated project folder name. For example, rename
MyProject 4.23toMyProject4.23.

5 Use MATLAB to open the migrated project in Unreal Editor 4.23. For example, if you have a
migrated project saved to the C:/Local folder, use this MATLAB code:

path = fullfile('C:','Local', 'MyProject4.23"', 'MyProject.uproject');
editor = sim3d.Editor(path);
open(editor);

Note The R2020a support package includes changes in the implementation of some actors.
Therefore, if the original project contains actors that are placed in the scene, some of them might
not fully migrate to Unreal Editor 4.23. To check, examine the Output Log.

EX Output Log

3
port 2 save 1 K

The log might contain error messages. For more information, see the Unreal Engine 4
Documentation or contact MathWorks Technical Support.

6 Optionally, after you migrate the project, you can use the project to create an Unreal Engine
executable. See “Package Scene into Executable Using Unreal Editor” on page 6-11.

Open Unreal Editor from MATLAB

When editing custom scenes, if you open the project file directly in the Unreal Editor, MATLAB and
Simulink do not establish a connection with the editor. Therefore, you cannot later simulate with
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these scenes in Simulink. Instead, you must you must open the editor from MATLAB by using the
sim3d.Editor function. This function creates an Editor object that contains the path to your
project file. You can then call the open function on this object to open the editor from MATLAB and
start editing your project.

Note The first time that you open the Unreal Editor from MATLAB, you might be asked to rebuild the
UE4Editor DLL files. Click Yes to rebuild them.

Open AutoVrtiEnv Project Containing Prebuilt Scenes

To open the AutoVrtlEnv.uproject file that was copied from the Vehicle Dynamics Blockset
Interface for Unreal Engine 4 Projects support package, specify the path to where you copied this
project. For example, if you copied the AutoVrtlEnv.uproject to C:/Local/AutoVrtlEnv, as
shown in the previous section, use this code:

path = fullfile('C:"', 'Local', 'AutoVrtlEnv', 'AutoVrtlEnv.uproject');
editor = sim3d.Editor(path);
open(editor);

The editor opens the AutoVrtlEnv.uproject file. By default, the project displays the Straight
Road scene.

Open Custom Project

To open a project that you developed using a prior release of the support package, see “Migrate
Projects Developed Using Prior Support Packages” on page 6-6.

To open your own project, use the same commands used to open the AutoVrtlEnv.uproject file.
Update the path variable with the path to your .uproject file. For example, if you have a project
saved to the C: /Local folder, use this code:

path = fullfile('C:"', 'Local', 'myProject', 'myProject.uproject');
editor = sim3d.Editor(path);
open(editor);

If this is your first time opening a custom project in Unreal Editor 4.23, you may need to associate, or
reparent, this project with the Sim3dLevelScriptActor level blueprint used in Vehicle Dynamics
Blockset. The level blueprint controls how objects interact once placed within in the Unreal
environment. If you do not reparent the project to this level blueprint, the simulation returns an error.

To reparent the level blueprint:

1 In the Unreal Editor toolbar above the editor window, select Blueprints > Open Level
Blueprint.
In the Level Blueprint window, select File > Reparent Blueprint.
Click the Sim3dLevelScriptActor blueprint and close the Level Blueprint window.

If you do not see this blueprint, make sure that you have the MathWorksSimulation plugin
installed and enabled.

a Navigate back to the editor window. In the toolbar above this window, select Settings >
Plugins.
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b In the Plugins window, verify that the MathWorks Interface plugin appears. This plugin
refers to the MathWorksSimulation.uplugin file that you copied into your local Unreal
Editor installation from the Vehicle Dynamics Blockset Support Package for Unreal Engine 4

Projects.

If you editor installation includes the plugin, then when you open a project in the editor for
the first time, you are prompted to enable this plugin. If you do not see the MathWorks
Interface plugin in this window, repeat the steps under and reopen the editor from

MATLAB.
Select the Enabled check box.

d Close the editor, reopen it from MATLAB, and repeat the steps to reparent the blueprint.

Create or Modify Scenes in Unreal Editor

After you open the editor from MATLAB, you can modify the scenes in your project before co-
simulation. You can also create scenes in your project.

Open Scene

In the Unreal Editor, scenes within a project are referred to as levels, and the specific level type for

these scenes are known as maps.

To open a prebuilt scene from the AutoVrtlEnv.uproject file, in the Content Browser pane
below the editor window, navigate to the Content > Maps folder. Then, select the map that

corresponds to the scene you want to modify.

Vehicle Dynamics Blockset Scene

Unreal Editor Map

Curved Road HwCurve

Double Lane Change DblLnChng

Open Surface BlackLake

Large Parking Lot LargeParkinglLot
Parking Lot SimplelLot
Straight Road HwStrght

US City Block USCityBlock

US Highway USHighway

Note The AutoVrtlEnv.uproject file does not include the Virtual Mcity scene.

To open a scene within your own project, in the Content Browser pane, navigate to the folder that

contains your scenes.

Send Data to Scene

The Simulation 3D Message Get block retrieves data from the Unreal Engine 3D visualization
environment. To use the block, you must configure scenes in the Unreal Engine environment to send

data to the Simulink model.
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For detailed information about using the block to customize the scenes, see the support package file
QuickStart Message Get Set and the Simulation 3D Message Get documentation.

Receive Data from Scene

The Simulation 3D Message Set block sends data to the Unreal Engine 3D visualization environment.
To use the block, you must configure scenes in the Unreal Engine environment to receive data from
the Simulink model.

For detailed information about using the block to customize the scenes, see the support package file
QuickStart Message Get Set and the Simulation 3D Message Set documentation.

Create New Scene
To create a scene in your project, from the top menu of the editor, select File > New Level.

Alternatively, you can create a scene from an existing one. This technique is useful, for example, if
you want to use one of the prebuilt scenes in the AutoVtrlEnv project as a starting point for
creating your own scene. To save a version of the currently opened scene to your project, from the
top menu of the editor, select File > Save Current As. The new scene is saved to the same location
as the existing scene.

Modify Scene

You can modify scenes in a project by dragging and dropping scene objects in the Unreal Editor.
Alternatively, you can select a scene object in the editor window and then modify its properties in the
Details pane on the right. For example, to change the position, orientation, or size of an object, in the
Details pane, use the options in the Transform section.

The Unreal Editor uses a left-hand Z-up coordinate system, where the Y-axis points to the right. When
positioning objects in a scene, keep this coordinate system difference in mind.

For more advanced information on modifying scenes in the Unreal Editor, see the Unreal Engine 4
Documentation.

Add Objects to Scene

To add objects to a scene, you can browse or search for objects in the Content Browser pane at the
bottom and drag them into the editor window.

When adding objects to a scene in the AutoVrtlEnv project (or a scene in a project that was based
off this project), you can choose from a library of driving-related objects. These objects, known as
static meshes, begin with the prefix sm_. Search for these objects in the Content Browser pane at
the bottom.

For example, to add a traffic cone to a scene in the AutoVrtlEnv project:

In the Content Browser pane at the bottom of the editor, navigate to the Content folder.

2 In the search bar, search for SM Cone. Drag the cone from the Content Browser into the editing
window. You can then change the position of the cone in the editing window or on the Details
pane on the right, in the Transform section.

To migrate these objects, also known as assets, from a AutoVrtlEnv-based project into your own
project file, see Migrating Assets in the Unreal Engine documentation.
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Co-Simulate Scene in Unreal Editor and Simulink

After you open a custom scene in the Unreal Editor, you can simulate this scene in both the editor and
Simulink. By using this co-simulation framework, you can add vehicles and sensors to a Simulink
model, and then play back this simulation in your custom scene. This kind of simulation workflow
enables you to tune your custom scene based on the simulation results before packaging the scene
into an executable.

To set up Simulink co-simulation with the Unreal Editor, in your Simulink model, double-click the
Simulation 3D Scene Configuration block. Set Scene source to Unreal Editor.

To run the simulation, in Simulink, click Run. Before you click Play in the Unreal Editor, wait until
the Diagnostic Viewer window displays this confirmation message:

In the Simulation 3D Scene Configuration block, you set the scene source to 'Unreal Editor'.
In Unreal Editor, select 'Play' to view the scene.

This message confirms that Simulink has instantiated the scene actors, including the vehicles and
cameras, in the Unreal Engine 3D environment. If you click Play before the Diagnostic Viewer
window displays this confirmation message, Simulink might not instantiate the actors in the Unreal
Editor.

By default, the Unreal Editor displays the scene from the scene origin. To display the scene from the
perspective of a vehicle, in the Simulation 3D Scene Configuration block, select the vehicle name
from the Scene view parameter. The next time you simulate within the editor, the scene displays
from the vehicle origin, which is on the ground, beneath the geometric center of the vehicle. To
change this view, use the numeric keypad in the editor.

Key Camera View
Back left 8
2 Back

Back
right

Left
Internal
Right
Front left
Front

w

O©| 00| || 01| &

Front
right (

0 Overhead 2

To restart a simulation, click Run in the Simulink model, wait until the Diagnostic Viewer displays the
confirmation message, and then click Play in the editor.

If you are co-simulating a custom project, for the numeric keypad to work in the editor, copy the
DefaultInput.ini file from the support package installation folder to your custom project folder.
For example, copy DefaultInput.ini from:

C:\ProgramData\MATLAB\SupportPackages\R2020a\toolbox\shared\sim3dprojects\automotive\AutoVrtlEnv\Config



Support Package for Customizing Scenes

to:

C:\<yourproject>.project\Config

Simulate Custom Scene Using Executable (Optional)

When you are satisfied with your custom scene, you can package the project file containing this scene
into an executable. You can then configure your model to simulate from this executable by using the
Simulation 3D Scene Configuration block. Executable files can improve simulation performance and
do not require opening the Unreal Editor to simulate your scene. Instead, the scene runs by using the
Unreal Engine that comes installed with Vehicle Dynamics Blockset.

To simulate a scene by using an executable, first package the project that contains the scene into an
executable. Then simulate this scene in your Simulink model.

Package Scene into Executable Using Unreal Editor
1 Open the project that contains the scene in the Unreal Editor. Use the sim3d.Editor function.

For more details, see the “Open Unreal Editor from MATLAB” on page 6-6 section.

2 In the menu above the editor window, select Settings > Project Settings to open the Project
Settings window.

3 In the left pane, in the Project section, click Packaging.
In the Packaging section, set these options:

Packaging Option Enable or Disable?
Use Pak File Enable

Cook everything in the project content |Disable
directory (ignore list of maps below)

Cook only maps (this only affects Enable
cookall)

Create compressed cooked packages Enable
Exclude editor content while cooking Enable

If you do not see all these options, at the bottom of the Packaging section, click the Show

0
Advanced expander )

5 Specify the scene from the project that you want to package into an executable.

a In the List of maps to include in a packaged build option, click the Adds Element
button .

b  Specify the path to the scene that you want to include in the executable. By default, the
Unreal Editor saves maps to the /Game/Maps folder. Therefore, if the /Game/Maps folder
has a scene named myScene that you want to include in the executable, enter /Game/Maps/
myScene.

¢ Add or remove additional scenes as needed.

Note Packaging a project into an executable can take several minutes. The more scenes that
you include in the executable, the longer the packaging takes.
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6 Close the Project Settings window.

7 In the top menu of the editor, select File > Package Project > Windows > Windows (64-bit).
Select a local folder in which to save the executable, such as to the root of the project file. For
example, C:/Local/myProject.

Once packaging is complete, the folder where you saved the package contains a
WindowsNoEditor folder that includes the executable file. This file has the same name as the
project file.

For example, suppose you package a scene that is from the myProject.uproject file and save
the executable to the C: /Local/myProject folder. The editor creates a file named
myProject.exe with this path:

C:/Local/myProject/WindowsNoEditor/myProject.exe

Note If you repackage a project into the same folder, the new executable folder overwrites the
old one.

Simulate Scene from Executable in Simulink

To improve co-simulation performance, consider configuring the Simulation 3D Scene Configuration
block to co-simulate with the project executable.

1 Inyour Simulink model, open the Simulation 3D Scene Configuration block.

2 Set these parameters:

* Scene source to Unreal Executable.

+ File name to the name of the Unreal Engine executable file, specified as a valid executable
name. You can either browse for the file or specify the full path to the file by using
backslashes. For example:

C:\Local\myProject\WindowsNoEditor\myProject.exe

* Scene to the name of a scene from the within the executable file, specified as the path to a

valid scene name. For example:
/Game/Maps/myScene
3 Run the simulation. The model simulates in the custom scene that you created.

Troubleshooting
Startup Warning

If you start Unreal Engine without following the steps in “Open Unreal Editor from MATLAB” on page
6-6 and “Co-Simulate Scene in Unreal Editor and Simulink” on page 6-10, you can get a warning that
reads: Warning: Integration with MATLAB/Simulink is not active. Unreal Engine might
crash if you then continue working with the Unreal Editor.

Error Creating Project Executable

To create a project executable, the MathWorksSimulation plugin must be located in the Unreal
Engine plugin folder. Check that the MathWorksSimulation plugin is not in the AutoVrt1lEnv
folder or subfolders. Set up the environment by following the steps in “Open Unreal Editor from
MATLAB” on page 6-6.



Support Package for Customizing Scenes

See Also

Simulation 3D Message Get | Simulation 3D Message Set | Simulation 3D Scene Configuration |
Virtual Mcity | sim3d.Editor

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-50

More About

. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6
. “3D Visualization Engine Requirements” on page 1-5

External Websites
. Unreal Engine
. Unreal Engine 4 Documentation
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Scene Interrogation with Camera and Ray Tracing Reference
Application

Interrogate a 3D scene with a vehicle dynamics model by using a camera and ray tracing reference
application project.

To create or modify other scenes, you need the Vehicle Dynamics Blockset Interface for Unreal
Engine 4 Projects support package. For more information, see “Support Package for Customizing
Scenes” on page 6-3.

”

For the minimum hardware required to run the example, see “3D Visualization Engine Requirements

on page 1-5.
For more information about the reference application, see “Scene Interrogation in 3D Environment”
on page 3-11.
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See Also

Simulation 3D Actor Transform Get | Simulation 3D Camera Get | Simulation 3D Scene Configuration

Capyright 2017-2019 The Mathiarks, Inc.

| Simulation 3D Vehicle with Ground Following | Vehicle Body 3DOF

More About

. “3D Visualization Engine Requirements” on page 1-5
. “Vehicle Dynamics Blockset Communication with 3D Visualization Software” on page 1-6
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External Websites
. Unreal Engine


https://www.unrealengine.com/en-US/what-is-unreal-engine-4
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Double Lane Change Reference Application

Simulate a full vehicle dynamics model undergoing a double-lane change maneuver according to
standard ISO 3888-2. You can create your own versions, establishing a framework to test that your
vehicle meets the design requirements under normal and extreme driving conditions. Use the
reference application for vehicle dynamics ride and handling analysis and chassis controls
development, including yaw stability and lateral acceleration limits.

For more information about the reference application, see “Double-Lane Change Maneuver” on page
34,

E
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Generator

Driver Commands
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Sensors

Help

Passenger Vehicle

Copyright 2018-2020 The MathWarks, Inc.

See Also
3D Engine | Mapped SI Engine | Predictive Driver | Vehicle Terrain Sensor

Related Examples

. “Send and Receive Double-Lane Change Scene Data” on page 3-50
. “Yaw Stability on Varying Road Surfaces” on page 1-18

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. Simulation Data Inspector



Swept Sine Steering Reference Application

Swept Sine Steering Reference Application

Simulate a full vehicle dynamics model undergoing a swept-sine steering maneuver. You can create
your own versions, providing a framework to test that your vehicle meets the design requirements
under normal and extreme driving conditions. Use the reference application for vehicle dynamics ride
and handling analysis and chassis controls development, including the dynamic steering response.

For more information about the reference application, see “Swept-Sine Steering Maneuver” on page
3-15.
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See Also
3D Engine | Longitudinal Driver | Mapped SI Engine | Vehicle Terrain Sensor

Related Examples
. “Frequency Response to Steering Angle Input” on page 1-49

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. Simulation Data Inspector
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Increasing Steering Reference Application

Simulate a full vehicle dynamics model undergoing a slowly increasing steering maneuver according
to standard SAE ]J266. You can create your own versions, establishing a framework to test that your
vehicle meets the design requirements under normal and extreme driving conditions. Use the
reference application for lateral vehicle dynamics ride and handling analysis and chassis controls
development, including the steering response.

For more information about the reference application, see “Slowly Increasing Steering Maneuver” on
page 3-22.
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3D Engine | Longitudinal Driver | Mapped SI Engine | Vehicle Terrain Sensor

Related Examples
. “Vehicle Steering Gain at Different Speeds” on page 1-30

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. Simulation Data Inspector



Constant Radius Reference Application

Constant Radius Reference Application

Simulate a full vehicle dynamics model undergoing a constant radius maneuver. You can create your
own versions, providing a framework to test that your vehicle meets the design requirements under
normal and extreme driving conditions. Use the reference application for vehicle dynamics ride and
handling analysis and chassis controls development, including the dynamic steering response.

For more information about the reference application, see “Constant Radius Maneuver” on page 3-29.
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[11]266 199601. Steady-State Directional Control Test Procedures for Passenger Cars and Light
Trucks. Warrendale, PA: SAE International, 1996.

[2]1 ISO 4138:2012. Passenger cars — Steady-state circular driving behaviour — Open-loop test
methods. Geneva: ISO, 2012.

See Also
3D Engine | Driver Commands | Reference Generator

Related Examples

. “Vehicle Lateral Acceleration at Different Speeds” on page 1-40

More About

. “Coordinate Systems in Vehicle Dynamics Blockset” on page 2-2
. Simulation Data Inspector
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Kinematics and Compliance Virtual Test Laboratory Reference
Application
Generate optimized suspension parameters for the vehicle dynamics mapped suspension blocks.

Generate Mapped Suspension from Spreadsheet Data uses Model-Based Calibration Toolbox™
to generate calibrated suspension parameters from measured vertical force and suspension geometry
data.

Generate Mapped Suspension from Simscape Suspension uses a Simscape™ Multibody™
suspension system to generate calibrated suspension parameters for the mapped suspension blocks.

Compare Mapped and Simscape Suspension Responses compares the mapped suspension with
the Simscape Multibody suspension results.

For more information about the reference application, see “Kinematics and Compliance Virtual Test
Laboratory” on page 3-41.
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See Also
Independent Suspension - Mapped | Solid Axle Suspension - Mapped



Kinematics and Compliance Virtual Test Laboratory Reference Application

More About

. Simulation Data Inspector
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Three-Axle Tractor Towing a Trailer

Ground

Trailer Ground Input

7-10

This example shows how to use a planar hitch to tow a three-axle trailer with a three-axle tractor. To
steer and drive the tractor, the model uses a sinusoidal wave steering input and an axle torque
applied to the rear wheels. To implement the tractor and trailer, the model uses the Vehicle Body
3DOF Three Axles and Trailer Body 3DOF blocks.

Model

Three-Axle Tractor Towing Trailer with Planar Hitch
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Run Simulation

Copyright 2019 The MathWorks, Inc.

Click play to run the simulation. As the simulation runs, the Vehicle Position window provides the

trace of the tractor and trailer.



Three-Axle Tractor Towing a Trailer
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Three-Axle Tractor Subsystem

To steer and drive the tractor, the three-axle tractor subsystem uses a sinusoidal wave steering input
and an axle torque applied to the rear wheels. The subsystem includes models for the wheels,
suspension, and vehicle body.
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#xle Torque
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Three-Axle Trailer Subsystem

The three-axle tractor subsystem includes models for the wheels, suspension, and the trailer body.
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Planar Hitch Subsystem

The three degree-of-freedom (DOF) planar hitch model allows relative longitudinal, lateral, and yaw
motion between the tractor and trailer. To limit the longitudinal and lateral motion, the hitch model
implements a stiff spring. The spring force is a function of the planar distance from the tractor hitch
location to the trailer hitch location in the inertial reference frame. The resulting spring force
approximately limits the relative motion between the tractor and trailer to yaw rotation about a
vertical axis at the hitch connection point. The hitch model transfers the vertical hitch force from the

trailer to the tractor.
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